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Chapter 1

Introduction and Installation

Biblio-Link II
Biblio-Link II is a configuration file editor. ProCite uses configuration
files to transfer records from information services into your ProCite
databases. Each configuration file identifies data elements such as author,
title, and publication date, and maps them to the appropriate fields in your
ProCite database. Because systems vary greatly in what information they
retrieve and how they save it to disk, you typically need a custom
configuration file for each system.

Many configuration files are supplied with ProCite, but you can modify
them or create new configuration files with Biblio-Link II. For a list of
configuration files supplied with ProCite, see Appendix D: Configuration
Files.

To actually transfer tagged text into ProCite with the configuration files,
use the ProCite Tools menu to Import Text File . This procedure is
described in your ProCite User's Guide, Chapter 9: Importing Records.

Downloading Information
You can retrieve information from many different online, CD-ROM,
diskette, and Online Public Access (OPAC) databases. It is your responsi-
bility to subscribe to the information service and pay any required fees for
downloading and storing records. Biblio-Link II and ProCite are intended
to enhance the use of these information services.

When retrieving from an online system, we recommend that you record
your entire search session—starting as soon as you sign on and stopping
after you sign off. Text appearing before records may contain a database
name that is critical for accurate record transfer. You must save to a text-
only file.
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Configuration files are set up to transfer tagged information. If your
information provider offers several download formats, make sure you use
the appropriate tagged format! See Appendix C: Sample Download Files
for tips about downloading from specific services and an example record
from each service.

Troubleshooting
If you have problems, first check Appendix A: Troubleshooting and the
online Help topics. If those do not answer your questions, contact ISI
ResearchSoft Technical Support.

Help Online
You can get online help in several ways:

• Select Help from the Menu bar to find a topic.

• Some windows have a Help command button; click on it to see
information related to the current window or dialog.

• Display a context-sensitive help topic by pressing the F1 key (Win-
dows) or the help key (Macintosh) . If no context-sensitive help is
available, choose from the list of topics.
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Technical Support
Technical support is available to all registered users, Monday through
Friday from 8:00 A.M. to 5:00 P.M. Pacific Time. When calling for
technical support, please use a phone near your computer and have your
serial number available.

To contact technical support:

Mail : ISI ResearchSoft
800 Jones Street
Berkeley, CA  94710
USA

Phone: +01 (510) 559-8592
Fax: +01 (510) 559-8683
Web Site:  http://www.procite.com

Email: Windows Technical Support: pc-procite@isiresearchsoft.com
Macintosh Technical Support: mac-procite@isiresearchsoft.com
Customer Service: info@isiresearchsoft.com

From Europe, please contact:

Mail : ISI ResearchSoft
Brunel Science Park, Bldg 1
Brunel University
Uxbridge  UB8 3PQ
UK

Phone: +44 1895-813544
Fax: +44 1895-237-313
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Using This Manual
This manual describes both Biblio-Link II for Windows and Biblio-Link
II for the Macintosh. The screen examples alternate between the Windows
product and the Macintosh product. Everything is essentially the same on
both platforms, including menu items and dialog boxes.

To find information and instructions in this manual, check the table of
contents at the front of the manual and/or the index at the back of the
manual.

Throughout this manual:

• A bold typeface is used when referring to menu names, menu items,
and buttons.

• ProCite field names and workform names are indicated with italics.

• Examples are in the sans serif Helvetica font.

Many menu items in Biblio-Link II have a corresponding keyboard
equivalent, and some items have a corresponding toolbar icon. The
keyboard equivalent appears on the menu next to the associated com-
mand. While this manual does not always mention keyboard equivalents
or toolbar icons, you can use them at any time.

Installation
Biblio-Link II is automatically installed in the ProCite program folder
when you install ProCite. If you have not yet installed ProCite, please do
so. If you installed ProCite previously and the Biblio-Link II program
does not appear in your ProCite program folder, please see your ProCite
User's Guide for information about reinstalling ProCite.
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Chapter 2

Getting Started: A Guided Tour

Overview
This chapter guides you through creating and using a basic configuration
file that works with a single database. You will identify different parts of
a download file, and add and map a database along with its field tags.
Setting up a configuration file involves:

• identifying new databases
• identifying the beginning and end of each record
• identifying the beginning and end of each field, and determining

the text format
• ignoring extraneous words or phrases between records
• adding and mapping databases
• adding and mapping field tags

This example transfers all records to a single workform, although you can
also add individual document types to a configuration file and map them
to ProCite workforms.

Because this manual describes both Biblio-Link II for Windows and
Biblio-Link II for the Macintosh, the screen examples alternate between
the Windows product and the Macintosh product. Everything is essen-
tially the same on both platforms.

You can stop this tour at any time by closing Biblio-Link II.

Examining the Downloaded Records
The first step in setting up a configuration file for a database is to
examine a download file of retrieved records. You must save records in a
tagged format to a text-only download file.

For this tour, we will create a configuration file that works with Medline
records retrieved from the National Library of Medicine's MEDLAR's
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system. A sample download file, titled "MEDLARS - Medline.txt"  is
found within the ProCite program folder, in the "Download" folder.

To look at the download file:

1. Start ProCite and create a new database named "Tour" (select New
from the File menu). This displays an empty record list.

2. Go to the Tools menu and select Import Text File .

3. In the Open Import File dialog, locate ProCite's "Download" folder
(under Windows, find "Program Files/ProCite4/Download") and open
"MEDLARS - Medline.txt." ProCite will display the download file.

You will often switch back to look at the download file while setting up a
working configuration file.

Note: You can also look at download files with a word processor. You can
print several pages in order to work with a paper copy, but it's often easier
to count spaces and characters onscreen.  Do not save any changes when
you close the file! It must remain text-only.
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Creating the Configuration File
To create a new configuration file:

1. Start Biblio-Link II from the ProCite 4 folder. Under Windows, use
the Start menu to launch Biblio-Link II from the ProCite program
group. A File Open dialog will display.

Note: Leave ProCite open in the background so you can switch back
to look at the download file.

2. Click Cancel to dismiss the File Open dialog.

3. From the File menu, select New to display a new file dialog.

4. In the file dialog,

a. Type the file name "Lesson". If you are working under Windows or
plan to share the file with a Windows user, add the extension .CFG.

b. Select the configuration file folder (ProCite 4/Config).

c. Click Save to create the configuration file on disk and display the
database list. A new configuration file starts with only a Default
database in the list, and with no field tags defined.

Tip : Adjust the column widths by dragging the column headers:
Name, Description, and Target ProCite Workform .
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Identifying Databases
Database Identifiers locate database names in your download file, so
Biblio-Link II will know from which database your records were re-
trieved. If the system you use maintains one large database, you don't
need to identify new databases, and can simply set up a single Default
database. However, many systems are made up of multiple smaller
databases.

To set up database identifiers:

1. Switch to ProCite to look at the download file. Scroll through the file
to find the text consistently used to identify the database. In MED-
LARS download files, the database name appears in a line like this:

YOU ARE NOW CONNECTED TO THE MEDLINE (1990 - 93) FILE.

Note: Depending on the service provider, you may need to examine
several different download files to find a consistent identifier.

2. Switch back to Biblio-Link II.

3. From the Configuration menu, select Database Identification. The
Database Identification screen appears.
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4. Click New to display the Database Identification Info dialog box:

5. In the Prefix box, type the character string that precedes the database
name in your download file. Don't forget the space at the end of the
string:

YOU ARE NOW CONNECTED TO THE

Since there is no consistent text after the database name, leave Suffix
blank.

6. Click OK to save the new settings.

Note: You could list multiple prefixes and suffixes; you would simply
click New again and enter another string. Biblio-Link II will search
the list of prefixes and suffixes to attempt a match in the download
file.

7. The right side of the Database Identification screen determines how
records are mapped when the configuration file does not identify a
database name in the download file. As you enter new databases, they
appear in this list.
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In this case, select None so ProCite will prompt you for the database
name during the import process.

8. Click Done to save your Database Identification settings.

9. From the File menu, select Save to save your changes to disk.

Identifying Records
Record identifiers mark the beginning and end of each record. They help
ProCite locate the beginning of a record, to start importing into a new
record in ProCite.  They also help identify the end of a record, so the
entire download file isn't put into one ProCite record.

To set up record identifiers:

1. Switch to ProCite to look at the download file. Find the text used to
identify the beginning of each record. In MEDLARS download files,
each record is numbered sequentially, such as:

1
UI  - 93143593
AU  - Popper SE ; McCloskey K
TI  - Individual differences and subgroups within populations: the
shopping bag approach.

2
UI  - 93141869
AU  - Battegay R
TI  - [Anxiety, a basic human experience]
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2. Switch back to Biblio-Link II.

3. From the Configuration menu, select Record Identification. The
Record Identification screen appears.

4. In the Header Format box, type the record header that appears before
each new record in your download file. In this case, type a pound sign
(#) to indicate "any number."

Tip : Use the pound sign (#) for "any number," and the asterisk (*) for
"any character." If you want to include a literal pound sign or asterisk
in your character string, precede it with a backslash (\). For example,
"\#" will specifically look for a pound sign in your text, while "#" will
look for any number.

5. In the Terminated By section, define the end of each record with
Blank Line, where each blank line signifies the end of the current
record

6. Click OK to save your settings.

7. From the File menu, select Save to save your file to disk.
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Identifying Fields
Field identifiers mark the beginning and end of each field, and the format
of each field. You must identify these correctly in order to transfer any
information.

To set up field identifiers:

1. Switch to ProCite to look at the download file. Examine the layout of
each field. In MEDLARS download files, the field tags are separated
from field text by "space space hyphen space" as shown below. The
"tag" is the code at the beginning of each field that identifies it, such
as AU for Author.

UI  - 93143593
AU  - Popper SE ; McCloskey K
AB  - The aerospace medical research community

needs to consider the individual as some
thing other than a statistical entity....

Notice that second and subsequent lines in a field are indented.

2. Switch back to Biblio-Link II.

3. From the Configuration menu, select Field Identification .  The Field
Identification screen appears.
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4. In the Tag Format box, enter the MEDLAR's format for a field tag.
To match this format:

AU  - Popper, SE

you should enter "$ - " (dollar sign, space, hyphen, space). Enter a
single space to indicate any number of spaces.

You can use these special characters as needed:

• $  (dollar sign) indicates the position of the tag itself
• #  (pound sign) means "any number"
• *  (asterisk) means "any character(s)

5. Indicate that the Tag Length is Fixed and enter a Field Tag Length
of 2, since all tags in the download file consist of two characters.

Note: Later, you may notice that the full MEDLARS configuration
file indicates a variable field tag length. That is because other MED-
LARS databases do allow variable-length tags. You are setting up this
example file only for Medline records.

6. Do not select CR Follows Tag; field text appears on the same line as
the field tag.

7. The distance from the beginning of a tag to the text of the field is
always the same number of characters, so select Fixed Width Tag
Area. When you select this, a text box appears. Enter the length
(number of characters, including spaces) in the text box: 6.

8. In the example download file, there is no character that appears at the
end of each field, nor is there any character that indicates an empty
field. Leave the Terminator and Empty String  boxes blank.

9. Use the pull-down list next to Line Continuation to select the
paragraph format used for field text. In this case, second and subse-
quent lines of text in a field are Indented.

10.Use the pull-down list next to Case Conversion to handle upper and
lowercase characters during the transfer. For these records, select No
Conversion to transfer text without any changes in case.

11.Click OK to save your settings.

12.From the File menu, select Save to save your file to disk.
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Identifying Extraneous Text
"Ignored strings" are extraneous lines of text that appear in your down-
load file that should not transfer into ProCite records. These are typically
command prompts from online systems. Any line beginning with an
ignored string is completely ignored for transfer.

To enter text you want ignored:

1. Switch to ProCite to look at the download file. Look for command
prompts at the beginning of the file, between records, and at the end of
the file. In the sample download file, you will find extra lines that
begin with:

USER:
PROG:
CONTINUE PRINTING?

While you may find other lines of extraneous text, it is only helpful to
list those lines that are consistent.

2. Switch back to Biblio-Link II.

3. From the Configuration menu, select Ignored Strings to display a
blank Ignored Lines dialog.

4. Click New to add a new line to the list. The Ignored Line Format
String dialog will appear.

5. Type "USER: " in the Line Format text box.

Tip : You can use these special characters: # (any number) and * (any
character).

6. Click OK to save your entry.

7. Click New again and enter "PROG: "; click OK to save the entry.
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8. Click New again and enter "CONTINUE PRINTING?"; click OK to
save the entry.

9. Click Done to save changes to the Ignored Lines dialog.

10.From the File menu, select Save to save your changes to disk.
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Adding and Mapping the Database
Now that ProCite can locate all the parts of the download file, you must
add and map the individual database itself.

To add and map a database:

1. Since this is a new configuration file, only the Default database
appears in the database list:

2. Click the New button. The Database Information dialog appears.

3. In the Name text box, type the database name "MEDLINE". The
database name is the name as it appears in your download file.

4. You can enter a longer name in the Description text box. This text
helps you identify the database. For this example, enter "Medline
(1990-1993)".
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5. Use the ProCite Workform  pull-down list to select Journal Long
Form as the destination ProCite workform. Records retrieved from the
database will transfer into this workform in ProCite.

Note:  You can map each database to a single ProCite workform.
However, if the records include a field that contains a description of
the document type, you can recognize and map those document types
to the appropriate ProCite workform. For this example, all records will
transfer to Journal Long Form.

6. Click OK to save the new database settings and display a blank field
list:
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Adding and Mapping Field Tags
Separate field lists are maintained for each database from an information
service. If your information provider offers a single database of records,
you can set up the Default database to work with all records. Otherwise,
you create a field list for each database.

Tip : For fields that are the same between databases, you can set the field
up once and then copy and paste that field definition for other databases.
See Chapter 7: Mapping Field Tags to ProCite Fields for more informa-
tion.

This section describes how to map fields you do not want transferred into
ProCite as well as normal text fields, author fields, source fields, and
keyword fields.

Determining Fields Tags and Matching ProCite Fields
Switch to ProCite and look at the download file. Compile a complete list
of field tags used in the file, a description of what is in each field, and a
target ProCite field for the text. Some records may contain tags not found
in other records.

If your information service provides a comprehensive field list, use it as a
guide so you include all tags. Keep in mind that tags used for searching
the database may not be the same tags saved to download files.

To determine target ProCite fields, use Appendix B: ProCite Workforms
and Fields. Since all of our example records are journal references, we
can map all fields to match ProCite's Journal Long Form workform.
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Our example file includes the tags listed below (you can enter the tags in
any order, although we've sorted these for you. The guided tour will walk
you through mapping several types of tags. You can then continue
mapping the rest of the tags on your own.

Tag Description........................ ProCite Field

AA Abstract Author ................... Do Not Transfer
AB Abstract .............................. 43 Abstract
AD Address .............................. Do Not Transfer
AU Author ................................. 01 Author, Analytic
DA Date of Entry ...................... Do Not Transfer
DP Date of Publication ............. 20 Date of Publication
EA English Abstract Indicator ... Do Not Transfer
EM Entry North ......................... Do Not Transfer
IP Issue/Part/Supplement ....... 24 Issue ID
IS ISSN ................................... 40 ISSN
JC Journal Title Code .............. Do Not Transfer
LA Language ........................... Do Not Transfer
MH MESH Headings ................. 45 Keywords
PG Pagination .......................... 25 Pages
PT Publication Type ................. Do Not Transfer
RN CAS Registry Number ........ Do Not Transfer
SB Journal Subset ................... Do Not Transfer
SO Source ................................ Do Not Transfer
TA Title Abbreviation ................ Do Not Transfer
TI Title ..................................... 04 Article Title
TT Translit/Vernac Title ............ 42 Notes
UI Unique Identifier ................. Do Not Transfer
VI Volume Issue ...................... 22 Volume ID
ZN Mesh Z Tree Number ......... Do Not Transfer
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Mapping a Field You Do Not Want in ProCite
First, we'll map a field that you do not want transferred into ProCite. You
need to add all field tags—even those you don't want transferred—so that
ProCite won't include the text as part of the previous field. In this case,
we'll map the field tag AA (Abstract Author).

To map a field you do not want transferred:

1. Switch back to Biblio-Link II if you are not already there.

2. From the Medline field list (which is currently blank), click the New
Field button at the bottom of the dialog. This displays a Field Infor-
mation dialog.

3. Enter basic information at the top of the dialog:

Field Tag : AA
Description : Abstract Author
ProCite Field : Do Not Transfer

When you select Do Not Transfer, other settings on the dialog are
ignored.

4. Click OK to save changes. You are returned to the field list, where AA
now appears.

5. Select Save from the File menu to save changes to disk.
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Note: The supplied configuration files are set up to transfer fields to
satisfy most users. You can modify the field transfer at any time! For
example, if the name of the abstract author is important to you, transfer it
to a ProCite field (perhaps the 42 Note field).

Mapping a Normal Text Field
Next, map the AB tag. This is a normal text field that requires no manipu-
lation. Most fields are transferred as normal text.

To map a normal text field:

1. From the Medline field list, click the New Field button at the bottom
of the dialog to display a Field Information dialog.

2. Enter basic information at the top of the dialog:

Field Tag : AB
Description : Abstract
ProCite Field : 43 Abstract

3. In the Attributes section of the Field Information dialog:

a. Set the Field Type to Normal Text so ProCite transfers the text
intact.
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b. Leave both the Begins With box and the Ends With box empty,
since MEDLARS does not mark the beginning or end of field text
with special text.

c. Set Case Conversion to Default to use the default setting for case
conversion. (We set no conversion as the default earlier.)

d. Leave the Space Character box empty, since MEDLARS does
not indicate spaces with a character.

e. Do not select the Compress Multiple Spaces box, since there are
no instances extraneous spaces in the download file.

4. When you selected the field type Normal, an extra Options section
appeared on the dialog.

a. Indicate that carriage returns are replaced by a Space.

b. Indicate that carriage returns are represented by Carriage Return
(Normal).

5. Click OK to save changes and return to the field list. The field tag AB
now appears in the list.

Tip : You can adjust column widths by dragging the column headers:
Tag, Description, Field Type, and Target ProCite Field.

6. Select Save from the File menu to save changes to disk.
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Mapping the Author Field
This section describes how to map an author field. Author names often
need manipulation so they will transfer into the appropriate ProCite
author format. The appropriate format is necessary so you can search for
author names in ProCite and print them in various output formats.

To add and map the AU field tag:

1. From the Medline field list, click the New Field button at the bottom
of the dialog to display a Field Information dialog.

2. Enter basic information at the top of the dialog:

Field Tag : AU
Description : Author
ProCite Field : 01 Author, Analytic

3. In the Attributes section of the Field Information dialog,

a. Set the Field Type to Author so ProCite can translate author
names into the appropriate ProCite format.

b. Leave both the Begins With box and the Ends With box empty,
since MEDLARS does not mark the beginning or end of field text
with special text.

c. Set Case Conversion to Default to use the default setting for case
conversion. (We set no conversion as the default earlier.)
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d. Leave the Space Character box empty, since MEDLARS does
not indicate spaces with a character.

e. Do not select the Compress Multiple Spaces box, since there are
no instances extraneous spaces in the download file.

4. When you selected the field type Author, an extra Options--Author
section appeared on the dialog.  Do not select the Corporate Author
box, since you want ProCite to translate personal author names.

5. Click OK to save changes.

6. Select Save from the File menu to save changes to disk.

You still need to indicate the author field format as described next.

Setting up the Author Field Format

You have mapped the AU field to a ProCite author field. Next, ProCite
needs to know what form author names appear in, so they can translate
into the correct form for ProCite. You need to set up the author field
format only once for each database, even if you map more than one
author field for the database.

To set up the author format:

1. Switch to ProCite to examine several AU fields in the download file.
Authors appear in this format:

Popper SE ; McCloskey K

2. Switch back to Biblio-Link II.

3. Make sure the Medline database is highlighted, or that the Medline
field list is displayed. A single author field format can be set up for
each database.

4. From the Configuration menu, select Author Field Format  to
display the current author format for the Medline database.
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5. Deselect the Use Default Database's Format box.

Note: If many of the databases from this service format author names
the same way, you may be able to simply check Use Default
Database's Format. For this example, however, we want to show you
how to set up an individual author format.

6. Toward the bottom of the dialog, clear the Spaces are represented by
hyphens box. This item shows or removes hyphens from the author
names on the dialog.

7. Click a radio button to select the author format that most closely
matches the author names in the download file. In this case, it is in the
right column:

8. At the bottom of the dialog, enter the character(s) that separate
individual author names. In this case, it is " ; " (space semicolon
space). When author names transfer into ProCite, these characters
translate into the ProCite author separator (//).

9. Click OK to save your changes.
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Mapping the Source Field
This section describes how to map the source field. Source fields contain
multiple types of information that should transfer into separate ProCite
fields. They contain some combination of journal title, date, volume,
issue, pages, ISSN, and CODEN. You need to split the field to accommo-
date searching and varied output.

To add and map the SO field tag:

1. From the Medline field list, click the New Field button at the bottom
of the dialog to display a Field Information dialog.

2. Enter basic information at the top of the dialog:

Field Tag : SO
Description : Source
ProCite Field : Do Not Transfer

Note: Normally, to parse the Source field, you would map to the
ProCite field 10 Journal Title. However, Medlars provides the same
information twice—in the SO field and in separately tagged fields.
For this tour, map to Do Not Transfer, so you will not get duplicate
entries in these fields (like two of the same dates in the date field).
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3. In the Attributes section of the Field Information dialog:

a. Set the Field Type to Parsed so ProCite can parse (separate) each
bit of information for transfer to appropriate ProCite fields.

b. Leave both the Begins With box and the Ends With box empty,
since MEDLARS does not mark the beginning or end of field text
with special text.

c. Set Case Conversion to Default to use the default setting for case
conversion. (We set no conversion as the default earlier.)

d. Leave the Space Character box empty, since MEDLARS does
not indicate spaces with a character.

e. Do not select the Compress Multiple Spaces box, since there are
no instances extraneous spaces in the download file.

4. When you selected the field type Parsed, an extra Options--Auto-
Parsed section appeared on the dialog.  Under Options--Auto-Parsed,
you indicate target fields in order to send each component to the
appropriate ProCite field.

Since our records are all journal entries, we are concerned with only
the Journal Long Form workform. For the journal workform, the
fields should map to:

Title .................. 10 Journal Title
Volume ............. 22 Volume ID
Issue ................ 24 Issue ID
Page Number .. 25 Pages
Date ................. 20 Date of Publication
ISSN ................ 40 ISSN
CODEN ............ 39 CODEN

The default settings work well with the predefined workforms. To
check the appropriate ProCite fields for the predefined workforms, see
Appendix B: ProCite Workforms and Fields.



34          Chapter 2:  Getting Started: A Guided Tour

By default, Title is mapped to field 09 Title, Monographic for journal
workforms; this accommodates users of earlier versions. When
ProCite 4 attempts to transfer to field 09 and discovers the field does
not exist in the workform, the data is redirected to field 10 Journal
Title. For this example, however, you will explicitly map the Title to
ProCite field 10 Journal Title.

a. Next to Title , click Select to display the Auto-Parsed Target Field
dialog. This dialog lists the target field for each workform.

b. Since our records are all journal entries, double click on Journal
Long Form  to display:

Use the drop-down list to select the 10 Journal Title field and click
OK to save the change.

c. Click Done to save the new setting.

5. Click OK to save changes to the Field Information dialog.

6. Select Save from the File menu to save changes to disk.

You still need to indicate the source field format as described next.
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Setting up the Source Field Format

You have mapped the SO field as a Parsed field. Next, ProCite needs to
know in what form the source field appears.

To set up the parsed format:

1. Switch to ProCite to examine several SO fields. Source fields appear
in this format:

Aviat Space Environ Med 1993 Jan; 64(1):74-7

Note the included fields, field order, and punctuation between fields:

Title Date; Volume(Issue):Pages

2. Switch back to Biblio-Link II.

3. Make sure the Medline database is highlighted, or that the Medline
field list is displayed. A single parsed field format can be set up for
each database.

4. From the Configuration menu, select Parsed Field Format to
display the current parsed field format for the Medline database.

5. Deselect the Use Default Database's Format box. The Example box
at the bottom of the dialog shows the current settings on the dialog.

6. Under Component, use the pull-down lists to list the order in which
items appear in your source fields.  In this case, list:

Title
Date
Volume
Issue
Pages
None
None

Note: If a component appears in most records, but not in others, you
should still include it here. For example, some records may contain all
five components (title, date, volume, issue, and pages) while others
may include only a subset. You would still list all five fields.
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7. Check the Optional box next to each of the five components. If they
appear, ProCite will parse them; if they don't appear the parsing
information for those fields is ignored.

8. In the Preceded By and Followed By text boxes, enter the text and/or
punctuation that separates each bit of information. In our example,

Aviat Space Environ Med 1993 Jan; 64(1):74-7

these settings work well to parse each item:

Don't forget spaces, which are significant. This example includes a
space after Title, a semicolon and space before Volume, parentheses
before and after Issue, and a colon before Pages.

These settings are rather subjective, since punctuation can be entered
as either ending text for one field or preceding text for the next field. It
is not always clear which will work best for ProCite.
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Tips: • When entering preceding and ending text for optional fields,
make sure you include only punctuation that appears or
disappears depending on whether the field is present.

• You can use an asterisk "*" as a wild card in preceding text,
meaning that any text is acceptable. For example, you could
use "*." as preceding text before the first component to get
rid of extraneous characters (that end with a period) before
the source information.

• You can use a backslash-r (\r) to indicate a line break after a
component.

9. To save changes to the parsing format for the Medline database, click
OK .

10.Select Save from the File menu to save changes to disk.

Mapping the Keyword Field
This section describes how to map a keyword field. Keywords are also
referred to as descriptors, categories, or headings. ProCite needs to
identify the field as multi-text in order to insert the appropriate separators.
Appropriate separators are necessary in ProCite so you can search by
keyword and organize bibliographies by subject.

To add and map the MH (Mesh Headings) field tag:

1. Switch to ProCite to examine several MH fields. These fields appear
in this format:

*Aerospace Medicine ; Fatigue/BLOOD ; G Suits ; Human;
*Human Engineering ; *Individuality ; Lactates/BLOOD ; Protec-
tive Devices ; Research ; Task Performance and Analysis

Note that keywords are separated by a space, a semicolon, and another
space. (Once the records are in ProCite, you may want to globally
remove the asterisks.)

2. Switch back to Biblio-Link II.
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3. From the Medline field list, click the New Field button at the bottom
of the dialog to display a Field Information dialog.

4. Enter basic information at the top of the dialog:

Field Tag : MH
Description : MESH Headings
ProCite Field : 45 Keywords

5. In the Attributes section of the Field Information dialog,

a. Set the Field Type to Multi-text so ProCite can translate keywords
into the appropriate ProCite format.

b. Leave both the Begins With box and the Ends With box empty,
since MEDLARS does not mark the beginning or end of field text
with special text.

c. Set Case Conversion to Default to use the default setting for case
conversion. (We set no conversion as the default earlier.)

d. Leave the Space Character box empty, since MEDLARS does
not indicate spaces with a character.

e. Do not select the Compress Multiple Spaces box, since there are
no instances extraneous spaces in the download file.
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6. When you selected the field type Multi-Text , an extra Options--Multi-
Text section appeared on the dialog.  Enter the character(s) that
separate keywords in the field. In this case, they are separated by " ; "
(space semicolon space). ProCite will replace the separator with a
slash during record transfer.

7. Click OK to save changes.

8. Select Save from the File menu to save changes to disk.

Mapping the Remaining Fields
You can continue mapping the rest of the fields until all appear in the
Medline field list —either as normal text fields or designated Do Not
Transfer.

Tag Description ........................ ProCite Field

AA Abstract Author .................... Do Not Transfer
AB Abstract ............................... 43 Abstract
AD Address ............................... Do Not Transfer
AU Author .................................. 01 Author, Analytic
DA Date of Entry ....................... Do Not Transfer
DP Date of Publication .............. 20 Date of Publication
EA English Abstract Indicator .... Do Not Transfer
EM Entry North .......................... Do Not Transfer
IP Issue/Part/Supplement ........ 24 Issue ID
IS ISSN .................................... 40 ISSN
JC Journal Title Code ............... Do Not Transfer
LA Language ............................ Do Not Transfer
MH MESH Headings .................. 45 Keywords
PG Pagination ........................... 25 Pages
PT Publication Type .................. Do Not Transfer
RN CAS Registry Number ......... Do Not Transfer
SB Journal Subset .................... Do Not Transfer
SO Source ................................. Do Not Transfer
TA Title Abbreviation ................. Do Not Transfer
TI Title ...................................... 04 Article Title
TT Translit/Vernac Title ............. 42 Notes
UI Unique Identifier .................. Do Not Transfer
VI Volume Issue ....................... 22 Volume ID
ZN Mesh Z Tree Number .......... Do Not Transfer
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When all the fields are mapped, click the close box to close the field list
and return to the database list.

Click the program close box, or Exit/Quit from the File menu, to close
the configuration file and leave Biblio-Link II. You may be prompted to
save changes.

The new configuration file is ready for use.

Importing the Records with ProCite
This section walks you through transferring a file of records retrieved
from the Medline database offered by the National Library of Medicine's
MEDLARS system. You will use the configuration file created during the
guided tour. (If you did not finish the guided tour, you can use the
MEDLARS configuration file supplied with ProCite.)

Note: While this process was accurate at print time, the ProCite program
may have changed slightly since then.

To import tagged records:

1. In ProCite, select Import Text File  to display the download file:

• If you have been following the Guided Tour, ProCite already has a
new database named "Tour" open. You already selected Import
Text File from the Tools menu to display the "Medlars -
Medline.txt" download file.

• If you have not been following the Guided Tour, start ProCite and
create a new database named "Tour." Go to the Tools menu and
select Import Text File  to display a file dialog. Locate and open
the text file that contains the tagged records you want to import
into ProCite. For this lesson, navigate to ProCite's "Download"
folder and select the file "MEDLARS - Medline.txt". ProCite will
display the file onscreen.
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2. In the File Type drop-down list, select Tagged.

3. In the File Format drop-down list, select the service from which you
retrieved the tagged records. In this case, select LESSON (the
configuration file created by following the Guided Tour) or MED-
LARS. If the file you want is not listed, use the ... button and use the
file dialog to locate the file.

4. In the Target Database drop-down list, select the "Tour" database. If
it is not listed, click on the ... button and use the file dialog to locate
the database.

5. Click the Transfer button to begin importing records.

When the transfer is completed, ProCite will tell you how many
records were imported into your database. Click OK to dismiss the
alert.
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6. Click the close box to close the text file and display the database
record list.

Tip : The imported records are marked. When you are adding to an
existing database, you can see only those records that you just
transferred by selecting Marked Records for viewing.

You can view full records to make sure fields of information transferred
correctly. If fields did not transfer into the ProCite fields of your choice,
you can:

1. Delete the marked records.

2. Start Biblio-Link II and modify the configuration file, changing field
mapping as appropriate.

3. Use ProCite to import the download file again.
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Chapter 3

Creating, Opening, and Managing
Configuration Files

Starting Biblio-Link II
When you install ProCite, a ProCite 4 folder is created containing a
ProCite icon and a Biblio-Link II icon. Double click on the Biblio-Link II
icon to start the program.

Or, from the Windows Start menu, you can go to Programs, then
ProCite, and select the Biblio-Link II  icon.

A File Open dialog will display, allowing you to find and select a con-
figuration file to open. If you want to create a new configuration file, first
click Cancel in the File Open dialog.

Creating, Opening, or Copying a Configuration File
You can create any number of configuration files. You can create a single
configuration file for each bibliographic data system you use, or you can
create a single configuration file for a specific database (or group of
databases) within a bibliographic data system.

Tip :  If you plan to create a configuration file that is similar to an existing
file, we recommend that you copy the existing file and modify it. This can
save you much time in entering field names, descriptions, applying field
attributes, etc.
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Creating a Configuration File
If you are working on a network drive, make sure you have read-write
access to the folder where you wish to create the configuration file.

To create a new configuration file:

1. Start Biblio-Link II. A File Open dialog will display.

2. Click Cancel to dismiss the File Open dialog.

3. From the File menu, select New to display a Save As dialog.

4. In the Save As dialog,

a. Type in a file name for the configuration file. This name is used to
store the file on disk.

b. Select the appropriate folder (typically the
Config folder found in the ProCite program folder).

c. Click Save to create the configuration file on disk and display the
database list. A new configuration file starts with only a Default
database in the list, and with no field tags defined.



Chapter 3:  Creating, Opening, and Managing Configuration Files          45

Opening a Configuration File
You can open a configuration file simply to check or print settings, or to
edit the file.

To open a configuration file when Biblio-Link II is not running:

1. Launch the Biblio-Link II icon. A File Open dialog will display.

2. Locate and open the configuration file to display the database list.

To open a configuration file when Biblio-Link II is already running:

1. Go to the File menu and select Open. A File Open dialog will display.

2. Locate and open the configuration file to display the database list.

Copying a Configuration File
Configuration files are disk files usually stored in the "Config" folder
found in the ProCite program folder. Under Windows, configuration files
always include the extension .CFG.

Open the file with Biblio-Link II and select Save As from the File menu.
In the Save As dialog, enter a name for the new configuration file, locate
the appropriate folder, and click Save to write the file to disk. Biblio-Link
II will display the new file.

You can also duplicate a configuration file with the Windows Explorer or
Macintosh Finder.
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Configuration File Properties
To view configuration file properties and add or update notes about the
file, go to the Configuration menu and select File Information .

Closing Files and Exiting Biblio-Link II
To close a configuration file, select Close from the File menu. Biblio-
Link II may prompt you to save changes. This closes the configuration
file, but Biblio-Link II is still open.

Click the program Close box to close all configuration files and exit
Biblio-Link II. Or, from the File menu, choose Exit (Windows) or Quit
(Macintosh).
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Backing Up Files
Loss of a custom configuration file is inconvenient, and it can be very
expensive to re-enter and re-map hundreds of field tags. Back up your
configuration files, especially after making numerous changes or addi-
tions.

We recommend that you keep an "archival" backup of your configuration
files (along with your ProCite files) on separate disks from your regular
backups. You will still have an old backup to restore even if your regular
backups were made after your hard disk developed a bad sector. Even an
archive that is several months old could save you from re-creating a
configuration file.

You can back up a single configuration file simply by copying it to a
diskette. If your file is large, or you want to back up several files, you can
use the Backup utility included with Windows or any backup utility
available from a third-party vendor.

Sharing, Deleting, and Renaming Files
Configuration files are separate disk files, and they are usually stored in
the "Config" folder found in the ProCite program folder.

You can share a configuration file with a user on another machine by
copying it to a diskette so that user can copy the file to his/her "Config"
folder. If you are sharing the configuration file with a ProCite for Win-
dows user, make sure the filename includes a .CFG extension.

If multiple users are running the same copy of ProCite from a network,
the installed configuration files are available to all of the users for data
importing with ProCite. However, when a configuration file is open for
editing, it is not available to other users for either editing or data import-
ing.

Use the Windows Explorer or Macintosh finder to delete or rename a
configuration file.
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Chapter 4

Locating Databases,
Records, and Fields

Overview
Database, record, and field identifiers define the overall layout of your
download files. You must define how downloaded information was
formatted to disk by the information service so ProCite can correctly
locate each item. If any one of these definitions is incorrect, you will
either have information transferred incorrectly or not at all. This chapter
explains how to examine your download file and define the appropriate
settings in a configuration file.

These settings should be the same for all files downloaded from a single
information provider.  If two databases from the same provider do not
share these settings, you must create two different configuration files.

In most cases, you need to set this information up only once. However, if
an information service changes the way records are output to disk, you
may need to modify these settings in the existing configuration file.

Examining Your  Download File
The first step in setting up a configuration file for an information service
is to examine a download file of records retrieved from that service. You
must retrieve records in a tagged format to a text-only download file. To
look at a download file, you can do one of these:

• Open it with a word processor. You may want to print several pages in
order to work with a paper copy.  Do not save any changes when you
close the file!

• In ProCite, go to the Tools menu and select Import Text File . In the
File Open dialog, select your download file for display.
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In the download file, you find unique characters or formatting that
determines how to:

• identify new databases
• find the beginning and end of each record
• find the beginning and end of each field, and the text format
• ignore extraneous words or phrases, such as "Hit return to continue"

The next section of this chapter, Entering Identifiers, explains how and
where to enter the appropriate settings with Biblio-Link II. As you go
through Entering Identifiers, you may want to refer to the download file
examples shown here. They illustrate the type of information you need to
determine from your own download file.

Example 1
This example is a slightly modified version of downloaded records from
MEDLARS. Several prompts and fields were removed for clarity. In
general, you should NOT modify your download file before transferring
records.
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These are the settings that will help identify components of the file:

Database Identification

Prefix: YOU ARE NOW CONNECTED TO THE

Record Identification

Header Format: #
(The pound sign indicates any number.)

Terminated By: One Blank Line
(There is a single blank line after each record.)

Field Identification:

Tag Format: $ -
(The dollar sign represents the tag, and the
"space hyphen space" appears between the tag
and the field text. Use a single space to indicate
any number of spaces.)

Tag Length: Variable
(While the example shows a fixed tag length of
two characters, further inspection of the file
found several three character tags. You may need
to scan an entire file to catch such variations.)

Line Continuation: Indented
(Second and subsequent lines in the same field
are indented.)

Case Conversion: No Conversion
(Most text is appropriately capitalized, so no
case conversion is applied. Note that the PT field
is in uppercase. You can later apply case conver-
sion only to that field.)

Ignored Lines:

Line Formats: USER:
PROG:
(The example shows only "USER:". You may
need to scan the entire file to find other extrane-
ous prompts saved to disk by the information
service.)
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Example 2
This example is a slightly modified version of downloaded records from
SilverPlatter. Several prompts and fields were removed for clarity. In
general, you should NOT modify your download file before transferring
records.
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These are the settings that will help identify components of the file:

Database Identification

Prefix: Record # of # -
(The pound sign indicates any number.)

Record Identification

Header Format: Record # of # - *
(The pound sign indicates any number, and the
asterisk indicates any characters.)

Terminated By: String:  ---------
(There is a line of hyphens after each record.)

Field Identification:

Tag Format: $:
(The dollar sign represents the tag, and the colon
appears between the tag and field text)

Tag Length: Variable
(The example shows both two and four character
tags.)

Line Continuation: Left Margin
(Second and subsequent lines in the same field
wrap to the left margin.)

Case Conversion: No Conversion
(Most text is appropriately capitalized, so no
case conversion is applied. Note that the LA field
is in uppercase. You can later apply case conver-
sion only to that field.)

Ignored Lines:

Line Formats: USER:
PROG:
(The example shows only "USER:". You may
need to scan the entire file to find other extrane-
ous prompts saved to disk by the information
service.)

Entering Identifiers
Database, record, and field  identifiers define the overall layout of your
download files. These settings should be the same for all files down-
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Entering Database Identifiers
Database Identifiers locate database names in your download file, so
Biblio-Link II will know from which database your records were re-
trieved.

If the system you use maintains one large database, you can ignore this
section. However, many systems are made up of multiple smaller data-
bases. Since you most likely will want to map items differently for
records from the different databases (records to workforms, and tagged
fields to ProCite fields), the configuration file needs to identify which
database from which records were retrieved.

If you haven't read it already, see Examining Your Download File earlier
in this chapter. It shows examples for determining what text identifies a
database name.

To set up a database identifier:

1. From the Configuration menu, select Database Identification. The
Database Identification screen appears.
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2. The left box lists text that appears before or after a database name in
your download file. This should be consistent text that will always
flag a database name. To add a character string to the list:

a. Click New to display the Database Identification Info dialog box:

b. In the Prefix box, type the character string that precedes a database
name or number in your download file.

Tip : Use special characters for varying items. Use # (pound sign)
for "any number" and use * (asterisk) for "any character."

For example, if this text indicates that the following records are
from the database MEDLINE:

Record 1 of 10 - MEDLINE

You would enter a Prefix of:

Record # of # -

c. In the Suffix box, type the character string (if any) that follows a
database name in your download file.

d. Click OK to save the new settings.

You can list multiple prefixes and suffixes; simply click New again
and enter another string. Biblio-Link II will search the list of prefixes
and suffixes to attempt a match in the download file.

You can modify or delete an existing item by highlighting it and
clicking the Modify or Delete button.
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3. The right side of the Database Identification screen determines how
records are mapped when the configuration file does not identify a
database name in the download file:

Biblio-Link II will not identify a database name when:

• The correct prefix and/or suffix strings have not been entered. You
need to determine what they are and enter them.

• The information system changed the strings used. You need to
enter the new strings.

• The database name was not included in the download file at all.
You need to find out whether your information system can include
it on output.

In most cases, you will want to select either None (ProCite may
prompt you for the database name during the import process) or the
Default database (where we recommend defining all common field
tags).

If you transfer records primarily from one particular database, you
may want to set that database as the default. Note that specific
database names do not appear until you have entered them as de-
scribed in Chapter 5: Adding and Configuring Databases.

4. Click Done to save your Database Identification settings.

5. From the File menu, select Save to save your changes to disk.
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Entering Record Identifiers
Record identifiers mark the beginning and end of each record. These are
critical. ProCite needs to know when a record has begun, to start import-
ing.  Plus, you don't want your entire download file dumped into one
ProCite record!

If you haven't read it already, see Examining Your Download File earlier
in this chapter. It shows examples for determining what text identifies a
new record.

To set up a record identifier:

1. From the Configuration menu, select Record Identification. The
Record Identification screen appears.

2. In the Header Format box, type the record header that appears before
each new record in your download file.

Tip : You can include special characters in your Header Format or
termination String. Use the pound sign (#) for "any number," and the
asterisk (*) for "any character." If you want to include a literal pound
sign or asterisk in your character string, precede it with a backslash (\).
For example, "\#" will specifically look for a pound sign in your text,
while "#" will look for any number .

For example, this header format:

Record # of #

would match this text:

Record 2 of 35
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3. In the Terminated By section, define the end of each record with one
of these:

• Blank Line, where each blank line signifies the end of the current
record

• Two or More Blank Lines, which allows for single blank lines
within a record (such as within an abstract) and two or more lines
between records

• String, where you then type the text string that ends each record

4. Click OK to save your settings.

5. From the File menu, select Save to save your file to disk.

Entering Field Identifiers
Field identifiers mark the beginning and end of each field, and the format
of each field. You must identify these correctly in order to transfer any
information.

If you haven't read it already, see Examining Your Download File earlier
in this chapter. It shows examples of what identifies a new field.

To enter a field identifier:

1. From the Configuration menu, select Field Identification .  The Field
Identification screen appears.
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2. In the Tag Format box, enter the information service's format for a
field tag. The "tag" is the code at the beginning of each field that
identifies it, such as AU for Author.

Use these special characters as needed:

• $  (dollar sign) indicates the position of the tag itself
• #  (pound sign) means "any number"
• *  (asterisk) means "any character(s)

For example, to match this format:

AU:  Rieger, Steve

you would enter:

$:

3. Indicate whether the Tag Length is Variable or Fixed.

• Select Variable if your tags are not all the same length.

• Select Fixed if all tags are the same length. A text box appears.
Enter the length of the tag. For example, the tag AU has a fixed
length of 2.

4. If your file displays a field tag on one line and the field text on the
next line, select the CR Follows Tag item.  An example of this is:

Author:
Smith, Gwendolyn
Title:
Childhood Allergies

5. If the distance from the beginning of a tag to the text of the field is
always the same number of characters, select Fixed Width Tag Area.
When you select this, a text box appears. Enter the length (number of
characters, including spaces) in the text box.

6. Under Processing Options, enter the field Terminator (if there is
one). For example, Dialog ends every field with a vertical bar "|".
Most services do not use a field terminator.

7. If the information service uses a character string to identify an empty
field, type that text in the Empty String box.  For example, it could
use the text "None".
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8. Use the pull-down list next to Line Continuation to select the format
used when field text consists of more than one line.

• Indented is where the next line is indented to the same column as
the previous text line, as in:

AU:  xxxxx
  xxxxx

• Left Margin  is where the new line is continued at the left margin,
as in:

AU:  xxxxx
xxxxxxxx

• Special Character is where continued lines are indicated by a
special character (otherwise each line is considered a new field), as
in:

AU:  xxxxx
*xxxxxxxx
*xxxxxxxx

The special character is not transferred to ProCite as text.

9. Use the pull-down list next to Case Conversion to handle upper and
lowercase characters during the transfer.

• No Conversion transfers text without any changes in case.

• Upper Case All changes all text to uppercase.

• Lower Case All changes all text to lowercase.

• Title Case changes the first character of each word to uppercase,
and all other characters to lowercase.

• Sentence Case changes the first character of each sentence to
uppercase and all other characters to lowercase. It cannot identify
proper nouns for capitalization.

Note: This setting affects all text transferred. You may prefer to apply
case conversion individually for each tagged field. For example, your
download file may show most fields with appropriate capitalization. If
Keywords is the only field displayed all in uppercase, you can apply
case conversion only to Keywords. This is described in Chapter 7:
Mapping Field Tags to ProCite Fields.
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10.Click OK to save your settings.

11.From the File menu, select Save to save your file to disk.

Entering Ignored Strings
Ignored strings are lines of text that appear in your download file but
should not transfer into ProCite records. These are typically command
prompts from online systems and lines such as:

continued on next page....

Any line beginning with an ignored string is completely ignored for
transfer. Do not use this feature if valuable information appears after the
ignored string on the same line.

To enter text you want ignored during importing:

1. From the Configuration menu, select Ignored Strings to display the
Ignored Lines dialog.

2. Click New to add a new line to the list. The Ignored Line Format
String dialog appears.
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3. Type the character string in the Line Format  text box.  You can use
the special characters, # (any number) and * (any character).

4. Click OK to save your entry.

5. Go back to step 2 if you want to enter additional ignored strings.

To modify or delete a string, select it and click the Modify or Delete
button at the bottom of the screen.

6. Click Done to save changes to the Ignored Lines dialog.

7. From the File menu, select Save to save your file to disk.
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Chapter 5

Adding and Configuring Databases

Overview
Some information services offer one large database for searching and
retrieving records. Other information services offer multiple databases for
record retrieval. Multiple databases, even though from the same informa-
tion provider, may vary significantly in what field tags are included on
output and how field text is formatted. In most cases, you can create one
configuration file for the information service, with separate mapping
instructions for each database offered by that provider.

You should already have your configuration file set up to recognize the
location of database names, records, and field tags in your download files.
Now you must add to the configuration file the actual database names you
want to recognize.

You can add databases, modify database settings, or delete databases at
any time.

The Default Database
If your information provider offers a single database, you can set up a
single Default Database. For systems with multiple database offerings,
the default database definition may be used when:

• the configuration file is not set up to correctly locate database names
in the download file

• a database name appears in the download file, but is not defined in the
configuration file

• no database name appears in the download file

You may want to define the Default Database with settings common
between most databases offered by the information provider. These
common settings are then available when a database name is not avail-
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able, and you can copy these common settings when you begin to define a
new database.

To define the Default Database settings or settings for a specific database,
see the next two sections, Adding and Mapping Databases and Modifying
Database Settings.

Adding and Mapping Databases
To add provider database names and map them to ProCite
workforms:

1. If it is not already open, open your configuration file. The database list
screen will display. If this is a new configuration file, only the Default
database will appear in the list:

2. Click the New button. The Database Information dialog appears:
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3. Type the database name in the Name text box (up to 64 characters).

Note:  The database name is the name that appears in your download
file. ProCite will attempt to match the name found in the download
file to the name entered here. While the official database name may be
long, such as "Excerpta Medica - Cardiology", you must use the
version that appears in  your download file, such as "Cardiology".

4. You can enter full database names in the Description text box (up to
64 characters). This is text to help you identify the database for
editing. For example, the Dialog system uses numbers as database
indicators in the download file, so the Description box is used for a
text description of the database.

5. Use the ProCite Workform  pull-down list to select a destination
ProCite workform. Records retrieved from the database will transfer
into this workform in ProCite.

Note:  At this basic level, you can map each database to a single
ProCite workform. This works great when an entire database contains
one type of record, such as all journal articles or all patents. If the
database combines different types of documents, pick the workform
that will work for the majority of records. However, if the records
include a field that contains a description of the document type, you
can later recognize and map those document types to the appropriate
ProCite workform. This is described in Chapter 6: Mapping Records
to ProCite Workforms.
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6. Click OK to save the new database settings and display a blank field
list:

7. At this point, you can:

• Start adding and mapping field tags as described in Chapter 7:
Mapping Field Tags to ProCite Fields.

• Click the close box to return to the database list, and continue
adding and mapping databases. You can add and map field tags
later.

Note:  As you enter databases, remember to often go to the File menu and
select Save.
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Modifying Database Settings
You can modify provider database names and settings at any time.

To modify provider database names and settings:

1. If it is not open already, open your configuration file. The database list
screen displays.

Note: If the provider offers a single database, only the Default
database appears in the list.

2. Highlight the database you wish to modify.

3. From the Configuration menu, select Database Information to
display the Database Information dialog:
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4. On the Database Information dialog you can modify:

• The database Name that appears in your download file (up to 64
characters). ProCite will attempt to match the name found in the
download file to the name entered here.

• The database Description (up to 64 characters). This is text to help
you identify the database.

• The target ProCite Workform . Records retrieved from the
database will transfer into this workform in ProCite unless a
document type field is present and used for workform selection.

5. Click OK to save the new database settings and return to the database
list.

6. To edit fields and field mapping (as described in Chapter 7: Mapping
Field Tags to ProCite Fields), double click on the database you want
to modify, or highlight it and click the Modify button. The field list
appears.

Note:  As you modify database settings, remember to often go to the File
menu and select Save.
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Copying Database Settings
Often, the easiest way to set up a new database is to copy the settings
from a similar database. When you copy database settings, you copy all
settings for that database, such as workform settings, document types
with mapping, and field tags with mapping. Then you can make the
(hopefully minimal) changes required.

To copy database settings:

1. In the database list, find and highlight the database whose settings
resemble the settings needed for a new database. This could be the
Default database, which may contain settings common to most
databases.

2. From the Edit menu, choose Copy to copy the database settings to the
clipboard.

3. From the Edit menu, choose Paste. A dialog will appear, telling you
that database already exists, and asking that you choose a new name
for the database.

4. Click OK to display the Database Information dialog.

5. On the Database Information dialog,

a. Enter a new database name and description.

b. If you need to, change the ProCite workform selection.

c. Click OK to save the settings.

You are returned to the database list, where the new database appears.
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Deleting Databases
When you delete a database from a configuration file, all of its database
definitions are deleted, including document types and field tags. You
cannot delete the Default database.

To delete a database:

1. Highlight the database name in a database list.

2. Click Delete. ProCite will ask for confirmation before deletion.

3. Click OK to permanently delete the database.
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Chapter 6

Mapping Records to
ProCite Workforms

Overview
At the most basic level, you can map all records from a single provider
database to a single ProCite workform. However, many databases contain
various document types; a single database could include references to
patents, journal articles, books, and dissertations. If your records include
a field indicating document type, you can add the document types to your
configuration file and map records to a specific workform in ProCite
based on document type.

This chapter explains how to map all records from a provider database to
a single ProCite workform, how to define a "document type" field from
your download file, and how to enter document type indicators and map
them to corresponding ProCite workforms.

Mapping a Database to a Pr oCite Workform
When you add a new provider database to a configuration file, you select
a matching ProCite workform for records from that database.

This is how you can modify the workform setting for a database:

1. In the database list, highlight the database whose settings you wish to
change.
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2. From the Configuration menu, choose Database Information. The
Database Information dialog appears:

3. Use the Workform  pull-down list to select a destination ProCite
workform. Records retrieved from the database will transfer into this
workform in ProCite.

Tip :  Pick the workform that will work for the majority of records. If
the records include a field that contains a description of the document
type, you can recognize and map those document types to the appro-
priate ProCite workform as described later in this chapter.

4. Click OK to save the new setting.

Recognizing the Document Type Field
In order to use the document type indicators in your records, ProCite first
needs to locate them. You need to define which field contains the docu-
ment type indicators. Look at records in your download file to find the
field. The document type field is set up separately for each database from
the information service, since even databases offered by the same
provider may have different settings.

Note: If you do NOT want to use the document type indicators in your
records, you can also follow the instructions below to make sure the
document type field is NOT flagged as a "Document Type" field. ProCite
will then use a single workform for all records from that database.

To add and/or modify the document type field:

1. In the database list, double click on the database whose settings you
wish to modify. Biblio-Link II displays a list of field tags already
defined for the database.



Chapter 6:  Mapping Records to ProCite Workforms          73

2. Modify or add the document type field tag (often the "DT" or "PT"
field).

• To add the tag, click New Field.

• To modify an existing tag's settings, double click on it. The Field
Type column will already show the attribute "Document Type" if
the field is already recognized as such.

The Field Information dialog appears:

3. Verify the Field Tag, Description, and target ProCite Field. You most
likely do not want to transfer the actual text of the document type field
into a ProCite field. In that case, make sure the ProCite Field item is
set to Do Not Transfer.

4. In the Field Attribute section, use the pull-down list to set the Field
Type option to Document Type. When you set the Field Type to
Document Type, an Options--Document Type section is added to the
dialog.

Note: If you do not want document types to determine the ProCite
workform, set the Field Type to Normal Text.

5. If some of the document type fields contain more than one document
type indicator, enter the separator in the box titled Document Types
Separated by. For example, this document type field contains two
indicators separated by a semicolon:

PT:  Article; Newspaper
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6. Click OK to save changes to the tag.

7. Click the close box to close the list of fields.

You have added and mapped the document type field itself. The next step
is to add the actual document type indicators that appear in the field. Map
each indicator to a corresponding ProCite workform as described in the
next section.

Adding and Mapping Document Types
Add and map document type indicators for each database from an
information service. Because the various databases originate from
different sources, document type indicators vary widely.

The document type indicators you enter must match the text that appears
in your download file; ProCite will attempt to match the document type
found in the download file to the name entered here. If the download file
includes several variations of the same document type, enter and map all
variations separately. For example, you may need to add all of these
variations and map each one to the Journal Article workform in ProCite:

Journal Article
Journ Art
Article

Some databases include more than one document type indicator in a
single document type field for a record. In this case, ProCite will use the
first indicator encountered and recognized. ProCite would use the Patent
indicator from this example:

DT -  Patent; Conference Proceeding

To add or modify a document type for a database:

1. In the database list, highlight the database name.

2. From the Configuration menu, select Document Types to display the
current list of recognized document types for that database.
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3. Add or modify a document type:

• To add a document type, click New.

• To modify an existing document type, double-click on it.

The Edit Document Type dialog appears:

4. In the Edit Document Type dialog:

a. Make sure the document type indicator entered here matches the
text found in your download file.

b. Use the drop-down list to select the appropriate ProCite workform
for records with this document type indicator.

c. Click OK to save changes, and Biblio-Link II returns you to the
Document Types list.
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5. At this point, you can:

a. Continue adding or modifying document types for this database.

b. Click Done to return to the database list.

You have added and mapped the actual document type indicators that
appear in your download file. If you haven't already, make sure you
define the document type field itself, as described under Recognizing the
Document Type Field earlier in this chapter.

Deleting Document Types
To delete a document type:

1. In the database list, highlight the database you wish to modify.

2. From the Configuration menu, select Document Types to display the
current list for the database.

3. Highlight the document type you wish to delete.

4. Click the Delete button.

5. When you are finished modify the list of document types, click Done
to return to the database list.
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Chapter 7

Mapping Field Tags to ProCite Fields

Overview
Each record in your download file is divided into tagged fields. ProCite
uses each tag to determine which target ProCite field will receive the
information in that field. For example, information tagged with "AU" or
"Author" will typically transfer into ProCite's 01 Author, Analytic field.

For each database offered by your information service, you can map each
field tag to an appropriate ProCite field. You can also use a "Do Not
Transfer" option for fields you do NOT want to transfer into your ProCite
records.

This chapter explains how to add field tags to your configuration file and
map those tags to corresponding ProCite fields, copy field tag definitions,
and delete field tags.

This chapter contains some information about appropriately mapping
multiple data fields such as author fields, source fields, and subfields. For
complete information about mapping these fields, see the appropriate
chapter later in this manual: Chapter 8: Setting the Author Field Format,
Chapter 9: Parsing Source Fields, or Chapter 10: Parsing Tagged
Subfields.

Adding and Mapping Field Tags
Separate field lists are maintained for each database from an information
service. If the service offers a single database of records, you can work
with only the Default database. Otherwise, you need to create a field list
for each database.

Tip : For fields that are the same between databases, you can set the field
up once and then copy that field definition for other databases. See
Copying Field Tag Definitions later in this chapter.
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To add a field tag or modify a field tag setting:

1. In the database list, double-click a database name to display the field
list for that database.

2. Display the Field Information dialog.

• To add a new tag, click the New Field button at the bottom of the
dialog.

• To modify the settings for an existing tag, double click on the field
tag.

3. Refer to the next three sections, which describe Mapping the Field
Tag, Setting Field Attributes, and Setting Field Type Options from this
Field Information dialog.

4. Click OK to save changes.

5. Select Save from the File menu to save changes to disk.
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Mapping the Field Tag
Enter basic information at the top of the Field Information dialog:

Field Tag: Enter the field tag as it appears in your download file. For
example, "AU" for an author field. You can enter up to 32
characters, so the field tag could actually be a long field
name.

Description: Enter a description of the field. This could be a long name
provided by your information service, or it could be a
note for your own use. You can enter up to 64 characters.
Months from now, it may not be as clear that "PD" means
"Publication Date," especially since it may have a
different meaning in another database, such as "Patent
Diagram."

ProCite Field: Use the ProCite Field drop-down list to select the
primary target ProCite field. Information from the tagged
field will transfer to the ProCite field selected here.

Tip : If you do NOT want to transfer the field text at all,
select Do Not Transfer. You can then click OK to save
the setting and leave the Field Information dialog.

Target Fields:

If you are transferring all records into a single ProCite workform, you can
ignore the Target Fields button and continue to the next section, Setting
Field Attributes.

If the configuration file is set up to recognize various document types that
will import into different ProCite workforms, you may need to use the
Target Fields button to override the primary target field for specific
workforms.

For example, you may have mapped an author field to ProCite field 01
Author, Analytic. That works well for most workforms, including Journal
Article. However, the Book Short Form workform does not include field
01; you should transfer author names to 07 Author, Monographic for
records in the Book Short Form workform.
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To override the default target field for a particular workform:

1. Click the Target Fields button to display a Target Fields list:

Each workform is listed along with the current target ProCite field. If
you are defining a new tag, all fields are mapped to the primary
ProCite Field set up for the tag. The workforms that do not contain
that ProCite field list a field number and dashes only (no field name).

2. Double click on a workform to change its target field. The Edit Target
Field dialog appears:

3. To override the primary target field for this workform, select the Use
alternate target field  button and use the drop-down list to select the
new ProCite field.

4. Click OK to save changes and return to the Target Fields list.
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5. At this point, you can do one of these:

• Continue overriding the target field for various workforms.

• Click Done to return to the Field Information dialog.

Now, move on to the next section, Setting Field Attributes.

Setting Field Attributes
Field attributes assigned to a tag help ProCite parse (separate) a multi-text
field and translate field text into the correct ProCite format.

In the Attributes section of the Field Information dialog:

1. Select a Field Type from the drop-down list.

Note: When you select a field type, an additional Options area may
appear on the dialog. These options are described in the next section
of this chapter, Setting Field Type Options.

The field type choices are:

Normal Text:  Transfer the text to ProCite with no changes in
formatting. This is the default setting that typically works for the
majority of fields.

Multi-Text :  The field contains multiple entries that should transfer to
the same ProCite field, such as a series of keywords.

Date:  The field contains a date.

Parsed:  The field contains multiple source information that should
transfer into separate ProCite fields. This field should contain some
combination of Journal Title, Volume, Issue, Pages, and/or Date. For
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information specifically about parsing source fields, see Chapter 9:
Parsing Source Fields.

Parsed with Subfields:  The field contains subfields of information
that are each tagged within this field. ProCite will look within the field
for field tags. For information specifically about parsing with sub-
fields and adding subfield tags, see Chapter 10: Parsing Tagged
Subfields.

Document Type:  The field contains a document type identifier, such
as "Journal Article" or "Book" that you wish to use to determine the
appropriate ProCite workform. For information specifically about
using document types to determine ProCite workforms, see Chapter 6:
Mapping Records to ProCite Workforms.

Literal Stream:  A field you want to transfer "as is" until another field
tag or new record is located in the download file. This is often a
"worst case scenario" field.  Use this feature when a field includes
blank lines or spaces that confuse the transfer (blank lines usually
indicate the end of a record, so would split a single record into two),
or when other characters confuse ProCite. This field type also lets you
transfer chemical equations or diagrams intact.

Author :  A field that contains author names. ProCite can translate
various forms of author names into the appropriate ProCite format.
For information specifically about transferring author names, see
Chapter 8: Setting the Author Field Format.

2. In the Begins With box, type text that is always included at the
beginning of the field (up to 20 characters) that should be ignored.
Most information services do not include this text, in which case you
would leave the box empty. In this example, "AU" is the field tag and
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"Author:" is the "Begins With" text:

AU -  Author: Smith, John

3. In the Ends With box, type text that marks the end of the field (up to
20 characters). Most information services do not include such text, in
which case you would leave the box empty. Dialog often uses a
vertical bar at the end of fields (|); you would enter it here to strip it
from the end of the field so it does not transfer to ProCite.

4. Case Conversion handles translation of upper and lowercase charac-
ters. The download file is not changed, but the text is modified for
import into ProCite.

Default: Uses the default setting for case conversion. This is
set on the Field Identification dialog (from the
Configure menu) for all records in the download
file.

No Conversion: Text imports into ProCite without any changes to
upper or lowercase characters.

Upper Case: All text in the field is converted to upper case
during import.

Lower Case: All text is lowercased during import.

Title Case: The first letter of each word is capitalized.

Sentence Case: The first letter of each sentence is capitalized
(proper nouns are not recognized as such).

5. In the Space Character box, type the character used to designate a
blank space. For example, hyphens may represent spaces in the field.
Most services do not signify spaces with a different character, in
which case you would leave this blank.

6. Select or deselect the Compress Multiple Spaces checkbox. When
selected, ProCite will replace multiple spaces with a single space.

7. If the Field Type you selected caused an additional Options section to
appear on the dialog, see the next section, Setting Field Type Options.
Otherwise, you can click OK to save the current field tag settings and
return to the field list.
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Setting Field Type Options
Depending on the Field Type attribute selected, an additional Options
area may appear on the Field Information dialog. If the field type is Date
or Literal Stream, no additional options appear. Field options for the
other field types are described in the following sections: Normal Text
Options, Multi-Text Options, Parsed Options, Parsed with Subfields
Options, Document Type Options, and Author Options.

Normal Text Options

For normal text, you need to indicate how carriage returns within a field
should transfer into ProCite. For systems that never include carriage
returns within a field, these settings are irrelevant.

Select one of these buttons for Replace Carriage Return with:

Space: Each carriage return gets replaced with a space. This is the
default setting, and works well for services that end each
line of text with a carriage return.

New Line: Each carriage return transfers as though you had entered a
carriage return in ProCite.

Character: Each carriage return is translated into the character you
enter in the adjacent text box.



Chapter 7:  Mapping Field Tags to ProCite Fields          85

Select one of these buttons for Carriage Return represented by:

Carriage Return: The information service uses a normal carriage
return. When you display invisible characters, it
shows up as the standard paragraph symbol.

Character: The information service indicates a carriage return
with the character you enter into the adjacent text
box. For example, Dialog often uses a caret (^) to
indicate carriage returns within a field.

Multi-Text Options

When a field contains multiple entries, such as a series of keywords, you
must indicate the character that separates each component.

For example, a keyword field may appear in your download file as:

KW:  Allergic-Asthma. House Dust. Mite. Lung Function.

You would enter a period and space as the separator. When transferred
into ProCite's 45 Keywords field, ProCite would replace the separator
with the appropriate ProCite separator:

Keywords (45): Allergic-Asthma/House Dust/Mite/Lung Function
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Parsed Options

When ProCite parses a Source field, you need to indicate target fields in
order to send the Journal Title, Volume, Issue, Pages, Date, ISSN and/or
CODEN to the appropriate ProCite fields.

To send source information to the appropriate target fields:

1. Next to Title , click Select to display the Auto-Parsed Target Fields
dialog:

This dialog lists the target field for each workform—in this case,
where the title will appear in the ProCite record. Since parsed fields
appear primarily in journal entries, make sure the field is mapped
appropriately for each of the journal workforms.
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If all of your records are transferring into one workform type, you
need to set the appropriate target field only for that workform. For
example, if all of your records are transferring to the Journal Long
Form workform, make sure the title is transferring to field 10: Journal
Title for that workform.

Tip : Appendix B: ProCite Workforms and Fields lists the predefined
workforms and their included fields.

Tip : If a tag is mapped to field 09 Title, Monographic and the destina-
tion workform does not include that field, ProCite will attempt to send
the text to field 10 Journal Title. This accommodates the Journal Title
field number change between ProCite 3 and ProCite 4.

2. To change a target field for a particular workform, double-click on that
line to display:

3. Use the drop-down list to select the appropriate ProCite field and click
OK to save the change.

4. You can continue changing the target field for each workform, double-
clicking on each line you wish to modify.

5. When you are done setting target fields for this parsed component,
click Done.

4. Go back to step 1, making sure each parsed component  (Title ,
Volume, Issue, Pages, Date, ISSN, and CODEN) is mapped to the
appropriate ProCite field by workform.



88          Chapter 7:  Mapping Field Tags to ProCite Fields

Parsed with Subfields Options

The field type Parsed with Subfields displays options for identifying
subfield tags. Enter the characters that surround subfield tags. The
Subfield Tags begin with item is optional, but you must enter something
in the and are followed by box. For this example,

SO- <PY> 1998  <VO> 25

you would enter "<" in the first text box and ">" in the second text box to
identify the subfields PY and VO.

Note: You need to map the individual subfields as described in Chapter
10: Parsing Tagged Subfields.

Document Type Options

When a document type field contains multiple document types, you must
indicate the separator or ProCite will look at the entire field as a single
document type indicator.
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For example, this is a common document type field:

DT:  Article; Conference Proceeding

You would enter a semicolon and space as the separator. ProCite would
use only the first document type (Article) in determining the appropriate
workform.

Author Options

Personal author names translate to the appropriate ProCite format during
the Import process. If the author field you are transferring contains only
corporate author names (companies, educational institutions, and govern-
ment agencies), select the Corporate Author  box so ProCite will not
attempt to manipulate the name.

Copying Field Tag Definitions
Each database in a configuration file has a separate list of field tags with
field mapping. However, there may be fields that are formatted exactly
the same from each database. Rather than enter and define each of these
field tags separately, you can enter a field for one database and then copy
that field and field definition for other databases.

Tip : You can copy a field to another database in the existing configura-
tion file or to a database in a different configuration file.

To copy a field tag definition:

1. In a database list, double click on a database name to display the field
list for that database.
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2. Highlight the field you wish to copy.

3. From the Edit menu, select Copy.

4. Close the field list.

5. In a database list, whether in the same configuration file or a different
configuration file, double click the database to which you want to add
the field.

6. From the File menu, select Paste. The field tag and definition is
pasted for that database.

Deleting Field Tags
These are situations where you might want to delete a field tag:

• The information system no longer includes that field in download files.
While you can leave the field tag without affecting data transfer, it may
be confusing.

• You are starting a new configuration file by copying an existing
configuration file. Delete those tags that aren't used by the new system
to clear a cluttered field list.

To delete a field tag and its definition:

1. In the database list, double click on the database you wish to modify.

2. In the field list, highlight the field tag you wish to delete.

3. Click the Delete button.



Chapter 8:  Setting the Author Field Format          91

Chapter 8

Setting the Author Field Format

Overview
To search by author and correctly format author names on output, ProCite
requires that author names transfer into ProCite Author fields, and that
those names appear in a specific format. ProCite can use the configura-
tion file to translate author names into the appropriate format.

You need to map fields containing author names to the appropriate author
fields in ProCite, and you need to indicate what form those names are in
so ProCite can translate them during import.

This chapter tells you how to define the author field format for each
provider database and how to map author information to the appropriate
ProCite fields.

Setting the Author  Format for  the Database
You can set a unique author format for each database or use the format set
up for the Default database.

• If the information service provides a single database, just set the format
for the Default database.

• If most of the databases from the information provider present author
names the same way, you can set the appropriate format up for the
Default database and then, for those databases that use the same format,
indicate that they should use the Default database format for author
names.

• If each database retrieves author names in a different way, you need to
set up an author format for each one.
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Examining the Author Fields
Examine your download files to determine the author format for each
database. If author names all appear in the same format, you can set up a
single author format for the default database and use that setting for all
databases. You can set a different author format for individual databases,
and you may need to do this if your information service provides data-
bases from many different sources.

Determine the order of information and the punctuation in the author
fields for records from each database. In this example,

AU:  Guglich E A.  Wilson P J.  White B N.

The information you need includes:

• Author names are presented with surnames first.

• Surnames are separated from initials by a space.

• Author names are separated by a period and a space.

Using the Default Database Setting
If many (or all) databases from a single information provider present
author names the same way, you can set up a single default format to use
for those databases.

To select a default author format for all databases:

1. In the database list of your open configuration file, highlight Default.

2. From the Configuration menu, select Author Field Format .
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3. If the Default database setting matches what you need for another
database, click Cancel to return to the database list.

If you want to modify the Default setting, see the next section, Setting
an Author Format.

4. For a database that uses the same author format as the Default,
highlight the database name in the list.

5. From the Configuration menu, select Author Field Format.

6. Check the Use Default Database's Format box at the top of the
dialog and click OK to save.

If you want to change the default database setting, or set up a custom
author format for another database, go to the section below, Setting an
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Author Format..

Setting an Author Format
To set up or modify an author format:

1. Determine the layout of author names in your download files as
described in Examining the Author Fields earlier in this chapter.

2. In the database list of your open configuration file, highlight the
database whose author format you wish to define. You can select any
individual database, including the Default.

3. From the Configuration menu, select Author Field Format  to
display the current author format for the highlighted database.

4. If it is selected, deselect the Use Default Database's Format box.

5. Toward the bottom of the dialog, select or deselect the Spaces are
represented by hyphens box. This item either shows or removes
hyphens from the author names on the dialog.

6. Click a radio button to select the author format that most closely
matches the author names in the download file.

7. At the bottom of the dialog, enter the character(s) that separate
individual author names. When author names transfer into ProCite,
this item translates into the ProCite author separator (//). The most
common separator is a semicolon and space.
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Adding the Tag as an Author  Field
Even though you may have an author format set up for a database (as
described in the previous section), ProCite cannot use that information
until a tagged field is assigned the field type "Author."

1. In the database list, double click on the database you wish to modify.

2. Open the field tag for the field that contains author names. Author
fields are typically tagged with AU, Author, Authors, or Name, but it
could have a unique tag.

• If it is already in the field list, double click on it.

• If it is not in the field list, click New Field.

3. Verify (or type in) the Field Tag and Description.

4. For ProCite Field, select the target ProCite author field. In most
cases, you should transfer author names to either 01 Author, Analytic
or 07 Author, Monographic.

5. Under the Attributes section, set the Field Type to Author . This tells
ProCite to translate author names using the Author Field Format.
Setting the Field Type to Author adds an additional Options--Author
section to the dialog.
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6. Under Options--Author, either select or deselect the Corporate
Author box. Select the box if author names in the download file are
primarily companies, universities or government agencies; ProCite
will not attempt to translate such names into the personal author
format.

7. Click OK on the Field Information dialog to return to the database
list.

8. Remember to Save changes from the File menu before you continue
modifying the configuration file.
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Chapter 9

Parsing Source Fields

Overview
When a tagged field contains a single type of information, such as a title,
it is easy to direct that field to a single corresponding ProCite field.
However, it is common to retrieve a single Source field that contains a
combination of title, volume, issue, pages, date, ISSN and/or CODEN as
in this example:

SO:  Journal of Allergy and Clinical Immunology. 92(6):802-811, 1993
Dec.

You need ProCite to parse (separate) each component and send each
component to the appropriate ProCite field. To do this, you need to:

• Set up a parsing format for the database, which indicates the order of
the components and the punctuation used to separate them.

• Add the field tag, indicate the field type "parsed," and map each
component to an appropriate ProCite field.

Note: This method of parsing a source field is necessary when source
information is separated only by punctuation. If the field contains
embedded field tags, see Chapter 10: Parsing Tagged Subfields.

Setting a Parsed Format for the Database
You can set a unique parsing format for each database or use the format
set up for the default database.

• If the information service provides a single database, you can set
everything up under the Default database.
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• If most of the databases from the information service present the source
information the same way, you can set the appropriate format up for the
Default database and then, for other databases, indicate that they should
use the Default database format for parsing.

• If each database retrieves source information in a different format, you
need to set up a parsing format for each one.

Note: Each database can recognize a single parsing format; if more than
one format is used for records from a single database, use the most
common form. Those records whose source fields do not use the most
common parsing format will require editing after transferring into
ProCite.

Examining Your Download Files
To determine the best way to parse source information, you need to
examine your download files. For each database, look at source fields
from many records. Hopefully they all appear in the same format; if not,
choose the most common format. You can set a single parsing format for
each database.

Determine the order of information and what punctuation or text sepa-
rates each item of information.

In this example,

SO:  Journal of Allergy and Clinical Immunology. 92(6):802-811, 1993
Dec.

you can see that:

• five fields are presented in this order: journal title, volume, issue,
pages, date

• a period and space separates the journal title and volume

• a left parentheses separates volume and issue

• a right parentheses and colon separates issue and pages

• a comma and space separates pages from date

This specific information will help you define an accurate parsing format.
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Using the Default Database Settings
If many databases from a single information provider present source
information the same way, you can set up a single default parsing format
to use for those databases.

To set up a default parsing format:

1. In the database list of your open configuration file, highlight Default.

2. From the Configuration menu, select Parsed Field Format.
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The Example box at the bottom of the dialog shows the current
settings for the Default database.

3. If the default database settings match what you need for another
database, click Cancel to return to the database list.

4. For a database that uses the same source field format as the Default,
highlight the database name in the list.

5. From the Configuration menu, select Parsed Field Format.

6. Check the Use Default Database's Format box at the top of the
dialog and click OK to save.

If you want to change the default database settings, or set up a custom
parsing format for another database, go to the next section, Setting a
Parsed Field Format.
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Setting a Parsed Field Format
To set up or modify a parsing format:

1. Determine the layout of your source fields as described in Examining
Your Download Files earlier in this chapter.

2. In the database list of your open configuration file, highlight the
database whose parsing format you wish to define. You can select any
individual database, including the Default.

3. From the Configuration menu, select Parsed Field Format to
display the current parsing format for the highlighted database.

4. Deselect the Use Default Database's Format box to set up a custom
format by entering specific parsing instructions. As you make
changes, they are reflected in the example at the bottom of the dialog.

5. Under Component, use the pull-down lists to list the order in which
items appear in your source fields. If there are fewer than seven
components in your source fields, set the last items(s) to None.

Tip : If a field appears in most records, but not in others, you should
still include it here. For example, some records may contain title, date,
volume, and issue, while others may include only title and date. You
would list all four fields.
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6. If a component does not always appear in the source field, check the
Optional box next to that field. In the example mentioned in the Tip
above, volume and issue are optional fields. If they appear, ProCite
will parse them; if they don't appear the parsing information for those
fields is ignored.

7. In the Preceded By and Followed By text boxes, enter the text and/or
punctuation that separates each bit of information. In this example,

SO:  Cancer. 72(12):3607-3613, 1993 Dec 15.

these settings work well to parse each item:

These settings are rather subjective, since punctuation can be entered
as either ending text for one field or preceding text for the next field. It
is not always clear which will work best for ProCite, and you may
need to return here to make modifications later.
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Tips:

• When entering preceding and ending text for optional fields, make
sure you include only punctuation that appears or disappears
depending on whether the field is present.

• You can use an asterisk "*" as a wild card in preceding text,
meaning that any text is acceptable. For example, you could use
"*." as preceding text before the first component to get rid of
extraneous characters (that end with a period) before the source
information.

• You can use a backslash-r (\r) to indicate a line break after a
component.

8. To save changes to the parsing format for the current database, click
OK to return to the database list.

Adding the Tag as a Parsed Field
Even though you may have a parsed format set up for a database (as
described in the previous section), ProCite cannot use that information
until a tagged field is assigned the field type "Parsed."

1. In the database list, double click on the database you wish to modify.

2. Open the field tag for the field you want to parse. In most cases, this is
a field tagged with SO, Source, or JN.

• If it is already in the field list, double click on it.

• If it is not in the field list, click New Field.

3. Verify (or type in) the Field Tag and Description.

4. For ProCite Field, enter the field you want used if ProCite cannot
parse the information. In most cases, this is the 10 Journal Title field.
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5. Under the Attributes section, set the Field Type to Parsed.  This adds
an additional Options--Auto-Parsed section to the dialog.

6. Under Options--Auto-Parsed, you need to indicate target fields in
order to send each title, volume, issue, page number, date, ISSN, and
CODEN to the appropriate ProCite field.

a. For each component, click Select to display the Auto-Parsed Target
Field dialog:

This dialog lists the target field for each workform. Since source
fields appear primarily in journal entries, make sure the field is
mapped appropriately for each of the journal workforms.
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If all of your records are transferring into one workform type, you
need to set the appropriate target field only for that workform. For
example, if all of your records are transferring to the Journal Long
Form workform, make sure the title is transferring to field 10:
Journal Title for that workform.

Tip : Appendix B: ProCite Workforms and Fields lists each of the
predefined workforms.

b. If you need to change the target field for a workform, double-click
on the line to display:

Use the drop-down list to select the appropriate ProCite field and
click OK to save the change.

You can change target fields for each workform, double-clicking
on each line you wish to modify.

c. When you are done setting target fields for a parsed component,
click Done.

Make sure each parsed component is mapped to the appropriate
ProCite field by workform.

7. Click OK on the Field Information dialog to return to the database
list.

8. Remember to Save changes from the File menu before you continue
modifying the configuration file.
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Chapter 10

Parsing Tagged Subfields

Overview
In most cases, each tagged field in a download file transfers to a single
corresponding ProCite field. However, some information systems embed
tagged information within a tagged field, as in these examples:

JN - <VO> 14 <IS> 3 <DT> January 1998

DE - MAJOR:  Asthma.  Allergy.  Immunology.  MINOR:  Homeo-
pathic Treatments. Bee Pollen.  Asthma Medications.

You will want to parse (separate) the field and direct each subfield to an
appropriate ProCite field. To do this:

• Indicate that the primary tag (the tag at the left margin) is the field type
"Parsed with Subfields."

• Add and map the subfield tags that appear within the field.

Adding the "Parsed with Subfields" Tag
To parse a field that contains subfields, you must first either add or
modify the primary tag.

To add or modify the primary tag:

1. In the database list, double click on the database you wish to modify.

2. Create or open the field tag for the field you need to parse (the field
that contains subfields):

• If it is already in the field list, double click on it.

• If it is not in the field list, click New Field.

3. Verify (or type in) the Field Tag and Description.
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4. For ProCite Field, select Do Not Transfer.

5. Under the Attributes section, set the Field Type to Parsed with
Subfields.  This adds an additional Options--Subfields section to the
dialog.

6. Enter the surrounding text that pinpoints the subfield tags.

a. In the Subfield Tags begin with box, enter the character or string
that appears before each subfield tag. This item is optional; some
systems follow a subfield tag with a colon or other character, and
do not use a starting character.

b. In the and are followed by box, enter the character or string that
follows each subfield tag. You must enter at least one character in
this box to help ProCite locate the subfield tags.

For the following example, you would enter "<" in the first text box
and "> " in the second text box to identify the subfields "VO," "IS,"
and "DT".

JN - <VO> 14 <IS> 3 <DT> January 1998
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For the next example, you would enter nothing in the first text box,
and ": " in the second text box to identify the subfields "MAJOR" and
"MINOR."

DE - MAJOR:  Asthma.  Allergy.  Immunology.  MINOR:  Homeo-
pathic Treatments. Bee Pollen.  Asthma Medications.

7. Click OK to save changes and return to the field list.

Now, you must map the individual subfields as described next.

Adding and Mapping the Subfield Tags
Before you can add subfields to your configuration file, you must first
enter the primary tag and flag it as "Parsed with Subfields." This is
described in the previous section.

Add each subfield that may appear within a single tagged field. The
subfields can appear in any order within the field.

1. On the database field list, highlight the tag that contains subfields and
click the Add Subfield button. The Field Information dialog appears:

2. A subfield is treated the same as any other field. Apply the Field
Information settings as needed specifically for the subfield text. If you
need help with these settings, see Chapter 7: Mapping Field Tags to
ProCite Fields.
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3. Click OK to save changes and return to the field list. The subfield
appears indented in the field list under the primary tag.

Note: As you add tags and subfield tags, remember to periodically
select Save from the File menu to save your changes to disk.

If the parsed field includes text before a subfield tag appears, you can add
a "null subfield" to map that initial text in the field.

To add a null subfield:

1. On the database field list, highlight the tag that contains subfields and
click the Add Subfield button to display the Field Information dialog.
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2. Leave the Field Tag area blank, and enter Null Subfield as the
Description.

3. Map to the appropriate ProCite field (or Do Not Transfer), and apply
the other Field Information settings as needed for the text. If you need
help with these settings, see Chapter 7: Mapping Field Tags to
ProCite Fields.

4. Click OK and the null subfield appears in the field list.
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Chapter  11

Printing Configuration File Settings

Overview
You can open a configuration file and print a report listing the configura-
tion file settings. You select the information to include in the report, so it
can be short or as detailed as you wish.

If your configuration file is large and you include field details to print,
your report could contain hundreds of pages. Because of this, Biblio-Link
II prints reports to a text file. You can then open the file to look at it with
a word processor and print it to a printer from your word processor if you
wish.

Printing Settings
To print a report of the settings in a configuration file:

1. Open the configuration file with Biblio-Link II if it is not already
open. From the Configuration menu, select Open Configuration to
display a file dialog. Locate and open the configuration file.

2. From the File menu, select Print Report . The Configuration Report
Preferences screen appears:
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3. Under Contents, select those items to include in the report:

• DL File Structure  includes the download file structure informa-
tion, listing the database designators (prefix and suffix character
strings).

• Database List includes a list of all databases included in the
configuration file.

• Database Details includes the database ID and description for
each database plus the target ProCite workform to use for records
from each database. You can also include the following:

* Database Field List includes a list of all fields defined for each
database, with the field tag, description, and target (ProCite)
field for each.

* Auto-Parse Formats includes the automatic parsing format for
each database.

* Field Details includes, for each defined field for each database,
the field tag, description, field type, default target field, space
character, whether to compress spaces, whether to do case
conversion, and the beginning and ending character strings. It
also lists field attribute options, which depend on the field type.

Note: Large configuration files have many field details. Your
report could contain hundreds of pages!

4. Click OK to accept your settings and display a Save As dialog.

5. Enter a name for the file, locate an appropriate folder to place it, and
click Save to write your configuration file report to disk.

6. Open the new text file with your word processor.

When you open the report with your word processor, you may need to
adjust tabs to line up columns.

You can print the report from your word processor to a printer as you
would any text document.
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Appendix A

Troubleshooting

This appendix describes situations you may encounter while setting up a
configuration file or while importing records into ProCite with a configu-
ration file.

I can't open a download file with Biblio-Link II

You cannot open a download file with Biblio-Link II. Use Biblio-Link II
to edit configuration files, and use ProCite to open download files and
import records. While earlier versions of Biblio-Link II actually trans-
ferred records, that functionality is now included in ProCite. In ProCite,
use the Tools menu to Import Text File .

ProCite imported nothing from the download file

First, make sure the download file is an ASCII text file. Display it with
ProCite (choose Import Text File  from the Tools menu and open the
download file). If you see odd characters or strange formatting, the file is
not ASCII text. You must download to an ASCII file. Once the file is
downloaded, you can view it with a word processor — but do not save it
as a word processor document. Once you do that, it is no longer an ASCII
text file.

Are you using the correct configuration file? For example, the Medline
database is offered by several information providers (Medlars,
SilverPlatter, etc.). Each provider may retrieve the same records in a
slightly different format, so using the appropriate configuration file is
critical.

If the download file is an ASCII file and you are using the correct
configuration file, ProCite either is not identifying the beginning of each
record or the beginning of fields. You need to tell ProCite how to identify
the beginning of each record, and how to determine the beginning of a
new field. Then, you need to add and map field tags. See Chapter 4:
Locating Databases, Records, and Fields for more information.
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One or more fields does not import

In the configuration file, double click on the database name and make
sure each field is included and mapped to a corresponding ProCite field.
Map to fields that are included in the target workform. Make sure the
fields you want are not mapped to Do Not Transfer. See Chapter 7:
Mapping Field Tags to ProCite Fields for complete information.

Only the first line of each field imports

You need to set the appropriate line continuation option in the configura-
tion file. In your download file, do the second and subsequent lines of a
field start at the left margin or are they indented? From the Configura-
tion menu, select Field Identification . Most likely, you need to set Line
Continuation to Indented.

The entire download file imported into a single ProCite record

ProCite most likely used the first field tag to determine that there was a
record at all. You need to specify how to identify the beginning of each
new record, and possibly how to identify the end of each record. Find
something unique that starts each record; it may be a number or a
consistent string of text or field tag. See Chapter 4: Locating Databases,
Records, and Fields. Then, make sure all the field tags have been added
and mapped for this database.

ProCite imports fields I do not want

In the configuration file, double click on the database name and make
sure the fields you do not want are listed and mapped to Do Not Transfer.
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Author names are not transferring correctly

First, make sure the author field(s) for this database are assigned the field
type Author .

Then, set the appropriate author field format for the database. Highlight
the database name, then go to the Configuration menu and select Author
Field Format. Select the author format and separator that matches author
names in the download file. See Chapter 8: Setting the Author Field
Format for more information.

If an author field uses commas both as part of an author's name and to
separate multiple author names, Biblio-Link II may not be able to
appropriately translate. In this example,

Jones, Robert, Smith, William, Brown, Randolph

Biblio-Link cannot distinguish the beginning of each new author name.
You should change the author field type to Normal and then edit the
author fields after transferring into ProCite.

The Source (or SO or JN) field transfers into a single ProCite field
or
Not all components of the source field transfer correctly

First, make sure the source field for this database is assigned the field
type Parsed. While on the Field Information dialog, make sure each
component of the source field is mapped to an appropriate ProCite field.

Then, check the parsing format set up for this database. Highlight the
database name, then go to the Configuration menu and select Parsed
Field Format. The fields must be listed in the order found in the source
field. Preceding and following punctuation must match the punctuation
separating each bit of information in the source field. Every separating
character is significant, including spaces.

Setting the parsed field format can be tricky. You may need to experiment
putting punctuation as either following text for an item or as preceding
text for the next item. You may also need to experiment assigning
Optional fields.
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If the source field does not have unique punctuation between items, it
may be impossible to accurately parse each item. For example, when each
item is separated by a space:

Liberal Education 73 Nov 1987 21-25

ProCite cannot tell where one item ends and another begins—especially
when the included fields change between records. You may need to
transfer into a single ProCite field and then edit your records.

Chapter 9: Parsing Source Fields has complete information about parsing
source fields.

How do I import different document types into various ProCite
workforms?

If each record contains a field that indicates document type, you can
transfer each into the appropriate workform.  First determine which
database the records are from; you set up document types by database.
For the field that contains the document type (usually the PT or DT field)
set the Field Type to Document Type.  Then, you need to add and map
the actual document types that appear in the field. See Chapter 6:
Mapping Records to ProCite Workforms for complete information.

Some bibliographic systems do not include a document type field in
downloaded records. In this case, the best you can do is map all records
from the database to a single ProCite workform. Pick the workform that
matches the majority of records. Once the records are in ProCite, you can
manually change workforms.

In either case, ProCite needs to identify the appropriate source database in
order to use the settings specific to that database. See Chapter 4: Locating
Databases, Records, and Fields.
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Appendix B

ProCite Workforms and Fields

Overview
This appendix lists the fields included in each of the workforms supplied
with ProCite, and then a list of all 45 ProCite fields. Field names can
change from workform to workform, but field numbers remain constant
for importing purposes.

Each record in a database uses a single ProCite workform. Each work-
form makes use of a subset of the 45 fields available in ProCite. The
workforms listed here are included with ProCite. You may have modified
some workforms, and you may have other custom workforms available.

Supplied Workforms

Abstract
Art Work
Audiovisual Material
Bill-Resolution
Book Chapter
Book Long Form
Book Short Form
Book Whole
Case
Computer Program
Conference Proceedings
Data File
Dissertation
Electronic Citation
Email
Generic
Hearing
In Press
Journal Article
Journal Long Form

Journal Short Form
Journal Whole
Letter
Magazine Article
Manuscript
Map
Monograph
Motion Picture
Music Score
Newspaper
Patent
Report
Sound Recording
Statute
Trade Catalog
Unenacted Bill-Resolution
Unpublished Work
Video Recording
Web Page
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Abstract

1 Author(s)
2 ———
3 ———
4 Title
5 ———
6 ———
7 ———
8 ———
9 ———

10 Journal Title
11 ———
12 Reprint Status
13 ———
14 ———
15 ———
16 ———
17 ———
18 ———
19 ———
20 Date of Publication
21 ———
22 Volume ID
23 ———
24 Issue ID
25 Page(s)
26 ———
27 ———
28 ———
29 ———
30 ———
31 ———
32 ———
33 ———
34 ———
35 ———
36 ———
37 Address/Availability
38 Location/URL
39 ———
40 ———
41 ———
42 Notes
43 Abstract
44 Call Number
45 Keywords

Art Work

1 Artist
2 Artist Role
3 ———
4 Title/Subject
5 Medium
6 Connective Phrase
7 Author, Monographic
8 Author Role
9 Title, Monographic

10 ———
11 ———
12 Reprint Status
13 ———
14 ———
15 Edition
16 ———
17 ———
18 Place of Publication
19 Publisher Name
20 Date of Publication
21 ———
22 ———
23 ———
24 ———
25 Location in Work
26 ———
27 ———
28 Size
29 ———
30 ———
31 ———
32 Series Title
33 ———
34 ———
35 ———
36 Connective Phrase
37 Address/Availability
38 Location/URL
39 ———
40 ———
41 ———
42 Notes
43 Abstract
44 Call Number
45 Keywords

Audiovisual Material

1 Author, Analytic
2 Author Role
3 ———
4 Title, Analytic
5 Medium Designator
6 Connective Phrase
7 Author, Monographic
8 Author Role
9 Title, Monographic

10 ———
11 ———
12 Reprint Status
13 ———
14 ———
15 Edition
16 Author, Subsidiary
17 Author Role
18 Place of Publication
19 Publisher Name
20 Date of Publication
21 ———
22 Volume ID
23 ———
24 ———
25 Location in Work
26 Extent of Work
27 Packaging Method
28 Size
29 ———
30 Series Editor
31 Series Editor Role
32 Series Title
33 Series Volume ID
34 Series Issue ID
35 ———
36 Connective Phrase
37 Address/Availability
38 Location/URL
39 ———
40 ———
41 ISBN
42 Notes
43 Abstract
44 Call Number
45 Keywords
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Bill-Resolution

1 Author(s)
2 ———
3 ———
4 Act Title
5 ———
6 ———
7 ———
8 ———
9 ———

10 ———
11 ———
12 Reprint Status
13 ———
14 ———
15 ———
16 ———
17 ———
18 Code
19 ———
20 Date of Code
21 Date
22 Bill/Res Number
23 ———
24 ———
25 Section(s)
26 ———
27 ———
28 ———
29 ———
30 ———
31 ———
32 History
33 ———
34 ———
35 ———
36 ———
37 Address/Availability
38 Location/URL
39 ———
40 ———
41 ———
42 Notes
43 Abstract
44 Call Number
45 Keywords

Book Chapter

1 Author, Analytic
2 ———
3 ———
4 Title, Analytic
5 Medium Designator
6 Connective Phrase
7 Author, Monographic
8 Author Role
9 Title, Monographic

10 ———
11 ———
12 Reprint Status
13 ———
14 ———
15 Edition
16 ———
17 ———
18 Place of Publication
19 Publisher Name
20 Date of Publication
21 ———
22 Volume ID
23 ———
24 Issue ID
25 Page(s)
26 ———
27 ———
28 ———
29 ———
30 ———
31 ———
32 ———
33 ———
34 ———
35 ———
36 Connective Phrase
37 Address/Availability
38 Location/URL
39 ———
40 ———
41 ———
42 Notes
43 Abstract
44 Call Number
45 Keywords

Book Long Form

1 Author, Analytic
2 Author Role
3 ———
4 Title, Analytic
5 Medium Designator
6 Connective Phrase
7 Author, Monographic
8 Author Role
9 Title, Monographic

10 ———
11 ———
12 Reprint Status
13 ———
14 ———
15 Edition
16 Author, Subsidiary
17 Author Role
18 Place of Publication
19 Publisher Name
20 Date of Publication
21 Date of Copyright
22 Volume ID
23 ———
24 Issue ID
25 Page(s)
26 Extent of Work
27 Packaging Method
28 ———
29 ———
30 Series Editor
31 Series Editor Role
32 Series Title
33 Series Volume ID
34 ———
35 ———
36 ———
37 Address/Availability
38 Location/URL
39 ———
40 ———
41 ISBN
42 Notes
43 Abstract
44 Call Number
45 Keywords
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Book Short Form

1 ———
2 ———
3 ———
4 ———
5 ———
6 ———
7 Author, Monographic
8 ———
9 Title, Monographic

10 ———
11 ———
12 Reprint Status
13 ———
14 ———
15 ———
16 ———
17 ———
18 Place of Publication
19 Publisher Name
20 Date of Publication
21 ———
22 ———
23 ———
24 ———
25 ———
26 ———
27 ———
28 ———
29 ———
30 ———
31 ———
32 ———
33 ———
34 ———
35 ———
36 ———
37 Address/Availability
38 Location/URL
39 ———
40 ———
41 ISBN
42 Notes
43 Abstract
44 Call Number
45 Keywords

Book Whole

1 ———
2 ———
3 ———
4 ———
5 ———
6 ———
7 Author, Monographic
8 Author Role
9 Title, Monographic

10 ———
11 Translated Title
12 Reprint Status
13 ———
14 ———
15 Edition
16 Author, Subsidiary
17 Author Role
18 Place of Publication
19 Publisher Name
20 Date of Publication
21 Original Pub Date
22 Volume ID
23 ———
24 ———
25 ———
26 Extent of Work
27 Packaging Method
28 ———
29 ———
30 Series Editor
31 Series Editor Role
32 Series Title
33 Series Volume ID
34 ———
35 ———
36 ———
37 Address/Availability
38 Location/URL
39 ———
40 ———
41 ISBN
42 Notes
43 Abstract
44 Call Number
45 Keywords

Case

1 Counsel
2 ———
3 ———
4 Case Name
5 ———
6 ———
7 ———
8 ———
9 Case Name (Abbrev)

10 ———
11 ———
12 Reprint Status
13 ———
14 ———
15 ———
16 ———
17 ———
18 Reporter
19 Court
20 Date Filed
21 Date Decided
22 First Page
23 ———
24 Reporter Number
25 Page(s)
26 ———
27 ———
28 ———
29 ———
30 ———
31 ———
32 History
33 ———
34 ———
35 ———
36 ———
37 Address/Availability
38 Location/URL
39 ———
40 ———
41 ———
42 Notes
43 Abstract
44 Call Number
45 Keywords
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Computer Program

1 ———
2 ———
3 ———
4 Program Title
5 Computer Program
6 Connective Phrase
7 Author/Programmer
8 Author Role
9 ———

10 ———
11 Title
12 Reprint Status
13 ———
14 ———
15 Version
16 ———
17 ———
18 Place of Publication
19 Publisher Name
20 Date of Publication
21 Date of Copyright
22 ———
23 Report ID
24 ———
25 ———
26 Extent of Work
27 Packaging Method
28 ———
29 ———
30 ———
31 ———
32 ———
33 ———
34 ———
35 ———
36 Connective Phrase
37 Address/Availability
38 Location/URL
39 ———
40 ———
41 ISBN
42 Notes
43 Abstract
44 Call Number
45 Keywords

Conference Proceeding

1 Author, Analytic
2 Author Role
3 Author Affiliation
4 Paper/Section Title
5 Medium Designator
6 Connective Phrase
7 Editor/Compiler
8 Editor/Compiler Role
9 Proceedings Title

10 ———
11 ———
12 Date of Meeting
13 Place of Meeting
14 ———
15 ———
16 ———
17 ———
18 Place of Publication
19 Publisher Name
20 Date of Publication
21 Date of Copyright
22 Volume ID
23 ———
24 ———
25 Location in Work
26 Extent of Work
27 Packaging Method
28 ———
29 ———
30 Series Editor
31 Series Editor Role
32 Series Title
33 Series Volume ID
34 ———
35 ———
36 ———
37 Address/Availability
38 Location/URL
39 ———
40 ———
41 ISBN
42 Notes
43 Abstract
44 Call Number
45 Keywords

Data File

1 ———
2 ———
3 ———
4 Title, Analytic
5 Medium (Data File)
6 Connective Phrase
7 Editor/Compiler
8 Editor/Compiler Role
9 Title, Monographic

10 ———
11 ———
12 Reprint Status
13 ———
14 ———
15 Version
16 ———
17 ———
18 Place of Publication
19 Publisher Name
20 Date of Publication
21 ———
22 ———
23 ———
24 ———
25 Location in Work
26 Extent of Work
27 Packaging Method
28 ———
29 ———
30 ———
31 ———
32 Series Title
33 Series Volume ID
34 ———
35 ———
36 Connective Phrase
37 Address/Availability
38 Location/URL
39 ———
40 ———
41 ———
42 Notes
43 Abstract
44 Call Number
45 Keywords
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Dissertation

1 Author, Analytic
2 ———
3 ———
4 Title, Analytic
5 Medium Designator
6 ———
7 ———
8 ———
9 ———

10 ———
11 ———
12 Reprint Status
13 ———
14 ———
15 ———
16 ———
17 ———
18 Place of Publication
19 University
20 Date of Publication
21 Date of Copyright
22 ———
23 ———
24 ———
25 ———
26 Extent of Work
27 Packaging Method
28 ———
29 ———
30 ———
31 ———
32 ———
33 ———
34 ———
35 ———
36 Connective Phrase
37 Address/Availability
38 Location/URL
39 ———
40 ———
41 ———
42 Notes
43 Abstract
44 Call Number
45 Keywords

Electronic Citation

1 Author(s)
2 ———
3 ———
4 Title
5 Medium
6 ———
7 Editors
8 ———
9 ———

10 Source
11 ———
12 Reprint Status
13 ———
14 ———
15 Edition
16 ———
17 ———
18 ———
19 Publisher Name
20 Last Update
21 Access Date
22 Volume ID
23 ———
24 ———
25 Page(s)
26 ———
27 ———
28 ———
29 ———
30 ———
31 ———
32 ———
33 ———
34 ———
35 ———
36 ———
37 Address/Availability
38 Location/URL
39 ———
40 ———
41 ———
42 Notes
43 Abstract
44 Call Number
45 Keywords

Email

1 Author(s)
2 Author E-mail
3 Author Affiliation
4 Subject
5 ———
6 ———
7 Recipient
8 Recipient E-mail
9 ———

10 ———
11 ———
12 Reprint Status
13 ———
14 ———
15 ———
16 ———
17 ———
18 ———
19 ———
20 Date of Message
21 ———
22 ———
23 ———
24 ———
25 ———
26 ———
27 ———
28 ———
29 ———
30 ———
31 ———
32 ———
33 ———
34 ———
35 ———
36 ———
37 Address/Availability
38 Location/URL
39 ———
40 ———
41 ———
42 Notes
43 Abstract
44 Call Number
45 Keywords
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Generic

1 Author, Analytic
2 ———
3 ———
4 Title, Analytic
5 ———
6 ———
7 Author, Monographic
8 ———
9 Title, Monographic

10 Journal Title
11 ———
12 Reprint Status
13 ———
14 ———
15 ———
16 ———
17 ———
18 Place of Publication
19 Publisher Name
20 Date of Publication
21 Date of Copyright
22 Volume ID
23 ———
24 Issue ID
25 Location in Work
26 ———
27 ———
28 ———
29 ———
30 Series Editor
31 ———
32 Series Title
33 ———
34 ———
35 ———
36 ———
37 Address/Availability
38 Location/URL
39 ———
40 ISSN
41 ———
42 Notes
43 Abstract
44 Call Number
45 Keywords

Hearing

1 Author(s)
2 Author Role
3 Author Affiliation
4 Title
5 Medium Designator
6 ———
7 ———
8 ———
9 ———

10 ———
11 ———
12 Reprint Status
13 ———
14 ———
15 ———
16 ———
17 ———
18 Committee
19 Subcommittee
20 Hearing Date
21 Date
22 Bill Number
23 ———
24 Issue ID
25 Location in Work
26 ———
27 ———
28 ———
29 ———
30 ———
31 ———
32 ———
33 ———
34 ———
35 ———
36 ———
37 Address/Availability
38 Location/URL
39 ———
40 ———
41 ———
42 Notes
43 Abstract
44 Call Number
45 Keywords

In Press

1 Author(s)
2 ———
3 ———
4 Title
5 ———
6 ———
7 ———
8 ———
9 ———

10 Journal Title
11 ———
12 Reprint Status
13 ———
14 ———
15 ———
16 ———
17 ———
18 ———
19 ———
20 Date of Publication
21 ———
22 Volume ID
23 ———
24 ———
25 Page(s)
26 ———
27 ———
28 ———
29 ———
30 ———
31 ———
32 ———
33 ———
34 ———
35 ———
36 ———
37 Address/Availability
38 Location/URL
39 ———
40 ———
41 ———
42 Notes
43 Abstract
44 Call Number
45 Keywords
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Journal Article

1 Author, Analytic
2 ———
3 ———
4 Article Title
5 Medium Designator
6 Connective Phrase
7 ———
8 ———
9 ———

10 Journal Title
11 Translated Title
12 Reprint Status
13 ———
14 ———
15 ———
16 ———
17 ———
18 ———
19 ———
20 Date of Publication
21 ———
22 Volume ID
23 ———
24 Issue ID
25 Page(s)
26 ———
27 ———
28 ———
29 ———
30 ———
31 ———
32 ———
33 ———
34 ———
35 Language
36 Connective Phrase
37 Address/Availability
38 Location/URL
39 ———
40 ISSN
41 ———
42 Notes
43 Abstract
44 Call Number
45 Keywords

Journal Long Form

1 Author, Analytic
2 Author Role
3 Author Affiliation
4 Article Title
5 Medium Designator
6 Connective Phrase
7 Author, Monographic
8 Author Role
9 ———

10 Journal Title
11 ———
12 Reprint Status
13 ———
14 ———
15 ———
16 ———
17 ———
18 ———
19 ———
20 Date of Publication
21 ———
22 Volume ID
23 ———
24 Issue ID
25 Page(s)
26 ———
27 ———
28 ———
29 ———
30 ———
31 ———
32 ———
33 ———
34 ———
35 ———
36 ———
37 Address/Availability
38 Location/URL
39 CODEN
40 ISSN
41 ———
42 Notes
43 Abstract
44 Call Number
45 Keywords

Journal Short Form

1 Author, Analytic
2 ———
3 ———
4 Article Title
5 ———
6 ———
7 ———
8 ———
9 ———

10 Journal Title
11 ———
12 Reprint Status
13 ———
14 ———
15 ———
16 ———
17 ———
18 ———
19 ———
20 Date of Publication
21 ———
22 Volume ID
23 ———
24 Issue ID
25 Page(s)
26 ———
27 ———
28 ———
29 ———
30 ———
31 ———
32 ———
33 ———
34 ———
35 ———
36 ———
37 Address/Availability
38 Location/URL
39 ———
40 ISSN
41 ———
42 Notes
43 Abstract
44 Call Number
45 Keywords
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Journal Whole

1 ———
2 ———
3 ———
4 ———
5 ———
6 ———
7 Editor
8 ———
9 ———

10 Journal Title
11 ———
12 Reprint Status
13 ———
14 Medium Designator
15 Edition
16 ———
17 ———
18 Place of Publication
19 Publisher Name
20 Date of Publication
21 ———
22 Volume ID
23 ———
24 Issue ID
25 ———
26 Extent of Work
27 Packaging Method
28 ———
29 Frequency of Publication
30 ———
31 ———
32 ———
33 ———
34 ———
35 ———
36 Connective Phrase
37 Address/Availability
38 Location/URL
39 CODEN
40 ISSN
41 ———
42 Notes
43 Abstract
44 Call Number
45 Keywords

Letter

1 Author, Analytic
2 ———
3 Author Affiliation
4 ———
5 Medium Designator
6 ———
7 Recipient
8 ———
9 ———

10 ———
11 ———
12 Reprint Status
13 ———
14 ———
15 ———
16 ———
17 ———
18 Place of Publication
19 ———
20 Date of Letter
21 ———
22 ———
23 ———
24 ———
25 ———
26 Extent of Letter
27 Packaging Method
28 ———
29 ———
30 ———
31 ———
32 ———
33 ———
34 ———
35 ———
36 Connective Phrase
37 Address/Availability
38 Location/URL
39 ———
40 ———
41 ———
42 Notes
43 Abstract
44 Call Number
45 Keywords

Magazine Article

1 Author(s)
2 ———
3 ———
4 Article Title
5 ———
6 ———
7 ———
8 ———
9 ———

10 Magazine Title
11 ———
12 Reprint Status
13 ———
14 ———
15 ———
16 ———
17 ———
18 Place of Publication
19 Publisher Name
20 Date of Publication
21 Date of Copyright
22 Volume ID
23 ———
24 Issue ID
25 Page(s)
26 ———
27 ———
28 ———
29 ———
30 ———
31 ———
32 ———
33 ———
34 ———
35 ———
36 ———
37 Address/Availability
38 Location/URL
39 ———
40 ———
41 ———
42 Notes
43 Abstract
44 Call Number
45 Keywords
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Manuscript

1 Author, Analytic
2 Author Role
3 ———
4 Title, Analytic
5 Medium Designator
6 Connective Phrase
7 ———
8 ———
9 Collection Title

10 ———
11 ———
12 Reprint Status
13 ———
14 ———
15 ———
16 ———
17 ———
18 ———
19 ———
20 Date of Publication
21 ———
22 ———
23 ———
24 ———
25 Location in Work
26 Extent of Work
27 Packaging Method
28 ———
29 ———
30 ———
31 ———
32 ———
33 ———
34 ———
35 Document Type
36 Connective Phrase
37 Address/Availability
38 Location/URL
39 ———
40 ———
41 ———
42 Notes
43 Abstract
44 Call Number
45 Keywords

Map

1 ———
2 ———
3 ———
4 Map Title
5 Map Type
6 ———
7 Cartographer
8 Cartographer Role
9 ———

10 ———
11 ———
12 Reprint Status
13 Area
14 Medium Designator
15 Edition
16 ———
17 ———
18 Place of Publication
19 Publisher Name
20 Date of Publication
21 Date of Copyright
22 ———
23 ———
24 ———
25 ———
26 Extent of Work
27 Packaging Method
28 Size
29 Scale
30 ———
31 ———
32 Series Title
33 Series Volume ID
34 Series Issue ID
35 ———
36 Connective Phrase
37 Address/Availability
38 Location/URL
39 ———
40 ———
41 ———
42 Notes
43 Abstract
44 Call Number
45 Keywords

Monograph

1 ———
2 ———
3 ———
4 ———
5 ———
6 ———
7 Author, Monographic
8 Author Role
9 Title, Monographic

10 ———
11 ———
12 Reprint Status
13 ———
14 ———
15 Edition
16 ———
17 ———
18 Place of Publication
19 Publisher Name
20 Date of Publication
21 ———
22 ———
23 ———
24 ———
25 ———
26 ———
27 ———
28 ———
29 ———
30 ———
31 ———
32 ———
33 ———
34 ———
35 ———
36 ———
37 Address/Availability
38 Location/URL
39 ———
40 ———
41 ISBN
42 Notes
43 Abstract
44 Call Number
45 Keywords
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Motion Picture

1 ———
2 ———
3 ———
4 Title, Analytic
5 Medium Designator
6 ———
7 Producer
8 Producer Role
9 ———

10 ———
11 ———
12 Reprint Status
13 ———
14 ———
15 ———
16 Director
17 Director Role
18 Place of Publication
19 Distributor
20 Date of Publication
21 ———
22 ———
23 ———
24 ———
25 ———
26 Timing
27 Packaging Method
28 Size
29 ———
30 ———
31 ———
32 Series Title
33 ———
34 ———
35 ———
36 Connective Phrase
37 Address/Availability
38 Location/URL
39 ———
40 ———
41 ISBN
42 Notes
43 Abstract
44 Call Number
45 Keywords

Music Score

1 Composer
2 Composer Role
3 ———
4 Title, Analytic
5 Medium Designator
6 Connective Phrase
7 Editor/Compiler
8 Editor/Compiler Role
9 Title, Monographic

10 ———
11 ———
12 Reprint Status
13 ———
14 Medium Designator
15 Edition
16 Author, Subsidiary
17 Author Role
18 Place of Publication
19 Publisher Name
20 Date of Publication
21 Copyright Date
22 Volume ID
23 Report ID
24 Plate Number
25 Location in Work
26 Extent of Work
27 Packaging Method
28 ———
29 ———
30 Series Editor
31 Series Editor Role
32 Series Title
33 Series Volume ID
34 Series Issue ID
35 ———
36 Connective Phrase
37 Address/Availability
38 Location/URL
39 ———
40 ———
41 ISBN
42 Notes
43 Abstract
44 Call Number
45 Keywords

Newspaper

1 Author, Analytic
2 Author Role
3 ———
4 Article Title
5 Medium Designator
6 Connective Phrase
7 ———
8 ———
9 ———

10 ———
11 Newspaper Name
12 Reprint Status
13 ———
14 ———
15 ———
16 ———
17 ———
18 Place of Publication
19 ———
20 Date of Publication
21 ———
22 Section
23 ———
24 Column Number
25 Page(s)
26 ———
27 ———
28 ———
29 ———
30 ———
31 ———
32 ———
33 ———
34 ———
35 ———
36 ———
37 Address/Availability
38 Location/URL
39 ———
40 ———
41 ———
42 Notes
43 Abstract
44 Call Number
45 Keywords
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Patent

1 Inventor
2 ———
3 Address
4 Patent Title
5 ———
6 ———
7 Assignee
8 ———
9 Title, Short Form

10 ———
11 Title, Long Form
12 Abstract Journal Date
13 Country
14 Document Type
15 Patent Number
16 ———
17 ———
18 Abstract Journal Title
19 ———
20 Date of Patent Issue
21 Application No./Date
22 Abstract Journal Volume
23 ———
24 Abstract Journal Issue
25 Abstract Journal Page(s)
26 Extent of Work
27 Packaging Method
28 ———
29 ———
30 ———
31 ———
32 ———
33 ———
34 ———
35 Language
36 Connective Phrase
37 Address/Availability
38 Location/URL
39 Class Code, National
40 Class Code, International
41 Related Document

Number
42 Notes
43 Abstract
44 Registry Number
45 Keywords

Report

1 Author, Analytic
2 Author Role
3 Author Affiliation
4 Section Title
5 Medium Designator
6 Connective Phrase
7 Author, Monographic
8 Author Role
9 Report Title

10 ———
11 ———
12 Reprint Status
13 ———
14 ———
15 Edition
16 Author, Subsidiary
17 Author Role
18 Place of Publication
19 Publisher Name
20 Date of Publication
21 ———
22 ———
23 Report ID
24 ———
25 ———
26 Extent of Work
27 Packaging Method
28 ———
29 ———
30 ———
31 ———
32 Series Title
33 Series Volume ID
34 Series Issue ID
35 ———
36 Connective Phrase
37 Address/Availability
38 Location/URL
39 CODEN
40 ———
41 ———
42 Notes
43 Abstract
44 Call Number
45 Keywords

Sound Recording

1 Composer
2 Composer Role
3 ———
4 Title, Analytic
5 Medium Designator
6 Connective Phrase
7 Editor/Compiler
8 Editor/Compiler Role
9 Recording Title

10 ———
11 ———
12 Reprint Status
13 ———
14 ———
15 Edition
16 Performer
17 Performer Role
18 Place of Publication
19 Publisher Name
20 Date of Publication
21 Date of Copyright
22 Acquisition Number
23 Matrix Number
24 ———
25 ———
26 Extent of Work
27 Packaging Method
28 Size
29 Reproduction Ratio
30 ———
31 ———
32 Series Title
33 ———
34 ———
35 ———
36 ———
37 Address/Availability
38 Location/URL
39 ———
40 ———
41 ISBN
42 Notes
43 Abstract
44 Call Number
45 Keywords
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Statute

1 Author(s)
2 ———
3 ———
4 Statute Title
5 ———
6 ———
7 ———
8 ———
9 ———

10 ———
11 ———
12 Reprint Status
13 ———
14 ———
15 ———
16 ———
17 ———
18 Code
19 ———
20 Date of Publication
21 Date
22 Title/Code Number
23 ———
24 ———
25 Section(s)
26 ———
27 ———
28 ———
29 ———
30 ———
31 ———
32 History
33 ———
34 ———
35 ———
36 ———
37 Address/Availability
38 Location/URL
39 ———
40 ———
41 ———
42 Notes
43 Abstract
44 Call Number
45 Keywords

Trade Catalog

1 Catalog Author
2 ———
3 ———
4 Catalog Title
5 Medium Designator
6 ———
7 ———
8 ———
9 ———

10 ———
11 ———
12 Reprint Status
13 ———
14 ———
15 Edition
16 ———
17 ———
18 Place of Publication
19 Publisher Name
20 Date of Publication
21 ———
22 Catalog Number
23 ———
24 Issue ID
25 ———
26 Extent of Work
27 Packaging Method
28 ———
29 ———
30 ———
31 ———
32 ———
33 ———
34 ———
35 ———
36 Connective Phrase
37 Address/Availability
38 Location/URL
39 ———
40 ———
41 ———
42 Notes
43 Abstract
44 Call Number
45 Keywords

Unenacted
Bill-Resolution

1 Author(s)
2 ———
3 ———
4 Act Title
5 ———
6 ———
7 ———
8 ———
9 ———

10 ———
11 ———
12 Reprint Status
13 ———
14 ———
15 ———
16 ———
17 ———
18 Code
19 ———
20 Date of Code
21 Date
22 Bill/Res Number
23 ———
24 ———
25 ———
26 ———
27 ———
28 ———
29 ———
30 ———
31 ———
32 History
33 ———
34 ———
35 ———
36 ———
37 Address/Availability
38 Location/URL
39 ———
40 ———
41 ———
42 Notes
43 Abstract
44 Call Number
45 Keywords
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Unpublished Work

1 Author(s)
2 ———
3 ———
4 Title
5 ———
6 ———
7 Editor(s)
8 ———
9 ———

10 ———
11 ———
12 Reprint Status
13 ———
14 ———
15 ———
16 ———
17 ———
18 ———
19 ———
20 Date of Publication
21 Date of Copyright
22 ———
23 ———
24 ———
25 ———
26 ———
27 ———
28 ———
29 ———
30 ———
31 ———
32 ———
33 ———
34 ———
35 ———
36 ———
37 Address/Availability
38 Location/URL
39 ———
40 ———
41 ———
42 Notes
43 Abstract
44 Call Number
45 Keywords

Video Recording

1 Author, Analytic
2 ———
3 ———
4 Title, Analytic
5 Medium Designator
6 ———
7 Producer
8 Producer Role
9 ———

10 ———
11 ———
12 Reprint Status
13 ———
14 ———
15 ———
16 Director
17 Director Role
18 Place of Publication
19 Distributor
20 Date of Publication
21 ———
22 ———
23 ———
24 ———
25 ———
26 Extent of Work
27 Packaging Method
28 Size
29 ———
30 ———
31 ———
32 Series Title
33 ———
34 ———
35 ———
36 Connective Phrase
37 Address/Availability
38 Location/URL
39 ———
40 ———
41 ISBN
42 Notes
43 Abstract
44 Call Number
45 Keywords

Web Page

1 Author(s)
2 Author Role
3 Author Affiliation
4 Title
5 ———
6 ———
7 ———
8 ———
9 ———

10 ———
11 ———
12 Reprint Status
13 ———
14 ———
15 ———
16 ———
17 ———
18 ———
19 ———
20 Date of Publication
21 Date of Access
22 ———
23 ———
24 ———
25 ———
26 ———
27 ———
28 ———
29 ———
30 ———
31 ———
32 ———
33 ———
34 ———
35 ———
36 ———
37 Address/Availability
38 Location/URL
39 ———
40 ———
41 ———
42 Notes
43 Abstract
44 Call Number
45 Keywords
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The 45 ProCite Fields

1 Author, Analytic/Author(s)/Artist/Catalog Author/Composer/Counsel/Inventor
2 Author Role/Artist Role/Composer Role/Author E-mail
3 Author Affiliation/Address
4 Title, Analytic/Act Title/Article Title/Case Name/Catalog Title/Map Title/Patent Title/Program Title/

Subject/Statute Title
5 Medium Designator/Computer Program/Data File/Medium/Map Type
6 Connective Phrase
7 Author, Monographic/Assignee/Editor/Programmer/Cartographer/Compiler/Producer/Recipient
8 Author Role/Cartographer Role/Editor Role/Producer Role
9 Title, Monographic/Case Name (Abbrev)/Collection Title/Recording Title/Report Title/Short Form Title

10 Journal Title/Magazine Title
11 Title/Newspaper Name/Translated Title/Subsidiary Title
12 Reprint Status/Date of Meeting/Abstract Journal Date
13 Country/Place of Meeting
14 Document Type/Medium Designator
15 Edition/Version
16 Author, Subsidiary/Director/Performer
17 Author Role/Director Role/Performer Role
18 Place of Publication/Abstract Journal/Code/Committee/Reporter
19 Publisher Name/Distributor/University/Subcommittee/Court
20 Date of Publication/Date of Letter/Patent Issue Date/Date of Code/Last Update/Hearing Date/

Date Filed
21 Date of Copyright/Original Publication Date/Access Date/Date Decided
22 Volume ID/Acquisition Number/Catalog Number/Section/Abstract Journal Volume/Bill-Res Number
23 Report ID/Matrix Number
24 Issue ID/Abstract Journal Issue/Plate Number/Reporter Number
25 Location in Work/Page(s)/Abstract Journal Pages/Section
26 Extent of Work/Extent of Letter/Timing
27 Packaging Method
28 Size
29 Reproduction Ratio/Frequency of Publication/Scale
30 Series Editor
31 Series Editor Role
32 Series Title/History
33 Series Volume ID
34 Series Issue ID
35 Document Type/Language
36 Connective Phrase
37 Address/Availability
38 Location/URL
39 CODEN/Class Code, National
40 ISSN/Class Code, International
41 ISBN/Related Document No.
42 Notes
43 Abstract
44 Call Number/Registry Number
45 Keywords
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Appendix C

Sample  Download Files

Overview
This appendix shows examples of download files from various informa-
tion systems, along with downloading tips as appropriate. ProCite ships
with configuration files that transfer these records. For a list of shipping
configuration files, and the databases with which they work, see Appendix
D: Configuration Files.

The configuration files shipped with ProCite are set up to work only with
bibliographic databases. Fields are mapped to transfer text to the most
likely matching field in ProCite. You may have different ideas about
where information should transfer, in which case you can modify the
configuration files. The configuration files were accurate at creation, but
information providers constantly update their systems. Again, you may
need to make modifications to accurately transfer text to the appropriate
ProCite workforms and fields.

If you plan to create a configuration file for a system not listed here, first
look at the sample records and find the records that are closest in format
to the records you want to transfer. It is often easier to modify a copy of
an existing configuration file rather than start with an empty configura-
tion file.

When downloading records, you should always record your entire search
session and save it to a text-only disk file. ProCite needs to identify the
source database as well as each record and each field within each record.
It's easy to delete unwanted records from ProCite after importing.

Included here are sample records from:

Current Contents on CD - OVID OVID Online
Current Contents on CD - Reprint OVID OVID
Dialog ProQuest
Medlars SilverPlatter
Melvyl STN
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Current Contents on CD - OVID
Use this configuration file: CC on CD - OVID
Sample Current Contents  OVID record from the Life Science database:

<20>
Accession Number
  MC193-0013
Document Delivery
  The Genuine Article Number: MC193
Authors
  Houston BJ.  Macallum GE.  Walker RM.  Albassam MA.
  Gough A.  Smith GS.
Title
  TOXICITY OF CI-949, A NOVEL ANTI-ALLERGY AGENT
Source
  Fundamental & Applied Toxicology.  21(3):376-383,
  1993 Oct.
ISSN
  0272-0590
KeyWords Plus
  Mediator release inhibitor.  Therapeutic efficacy.
  Immune function.  Polyarteritis.  Histamine.
Beagles.
  Asthma.  Rats.  Dog.
Language
  English
Publication Type
  Article
CC Categories
  Pharmacology.
Subset
  Current Contents/Life Sciences
Institution
  Reprint available from:
  Houston BJ
  PARKE DAVIS RES INST
  2270 SPEAKMAN DR
  MISSISSAUGA L5K 1B4
  ONTARIO
  CANADA

  WARNER LAMBERT PARKE DAVIS
  PARKE DAVIS PHARMACEUT RES
  ANN ARBOR, MI 48104
  USA
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Current Contents on CD-Reprint
Use this configuration file: CC on CD Reprint
Sample Current Contents Reprint record from the Clinical Science
database:

3
UI  - ML242-0009
AU  - Vanhagehamsten M
AU  - Harfast B
AU  - Johansson SGO
TI  - DUST MITE ALLERGY - AN IMPORTANT CAUSE OF
      RESPIRATORY DISEASE IN FARMERS
SO  - American Journal of Industrial Medicine.
      25(1):47-48, 1994 Jan.
IS  - 0271-3586
MH  - Lepidoglyphus destructor
MH  - Storage mites
MH  - Occupational asthma
MH  - Organic dusts
MH  - Storage mites.  Lepidoglyphus-destructor.
      Farming population
AB  - In 2,578 Swedish farmers, 6.2% were found to
      have an allergy to storage mites. The storage
      mite Lepidoglyphus destructor has been
      identified by both RAST and bronchial challenges
      as a significant cause of occupational asthma in
      rural environments. Immunohistochemical studies
      of L. destructor disclosed that at least one L.
      destructor allergen is associated with
      digestion.
      (C) 1994 Wiley-Liss, Inc. [References: 12]
LG  - English
PT  - Note
SB  - Current Contents/Clinical Medicine
IN  - Reprint available from:
      Vanhagehamsten M
      KAROLINSKA HOSP
      DEPT CLIN IMMUNOL
      BOX 60500
      S-10401 STOCKHOLM
      SWEDEN
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Dialog
Use this configuration file: DIALOG.CFG

When downloading, record your entire Dialog search session. The
supplied configuration file works best with records retrieved in tagged
Format 4. You can retrieve records in other tagged formats, but you will
need to modify the configuration file for accurate record transfer. You can
also transfer OneSearch records retrieved in a tagged format.

Sample Dialog record from database 1 (ERIC):

1/2/10
SO- <AN> EJ363746|
SO- <AN> HE523377|
TI- Something Strange Yet Nothing New: Religion in the
Secular Curriculum.|
AU- Green, William Scott|
SO- <JN> Liberal Education^v73 n5 p21-25 Nov-Dec|
SO- <PY> 1987|
AV- UMI|
LA- ENGLISH|
DT- JOURNAL ARTICLE (080); POSITION PAPER (120)|
JA- CIJAPR99|
DE- *College Curriculum^*Educational Attitudes^Higher
Education^Humanities Instruction^*Liberal
Arts^*Religion^ *Religious Education^*Social Values||
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Medlars
Use this configuration file: MEDLARS.CFG

Record your entire MEDLARS search session so ProCite can identify
database names. The supplied configuration file can transfer tagged
records retrieved with a standard communication package or the National
Library of Medicine's Grateful Med software, plus records from Beth
Israel Hospital's PaperChase system.

You will get more accurate results if you use the Print Detailed com-
mand when you retrieve MEDLARS records; it expands the SO (Source)
field for journals into separately tagged fields.

Sample MEDLARS record from MEDLINE in "Print Detailed" format:

1
UI -85276784
AU -Leeder JS
AU -Robertson C
TI -Evaluation of serum theophylline concentrations

following administration of sustained-release
beads in applesauce to asthmatic preschool
children.

LA -Eng
MH -Asthma/BLOOD/DRUG THERAPY
MH -Theophylline/ADMINISTRATION & DOSAGE/*BLOOD/

METABOLISM
DA -860318
DP -1986 Feb
IS -0003-4738
TA -Ann Allergy
PG -133-7
SB -M
ZN -Z1.107.567.875
IP -2
VI -56
JC -4XC
AA -Author
RM -58-55-9 (Theophylline)
EM -8605
AB -A sustained-release theophylline preparation

(Theo-Dur Sprinkle) was evaluated in young
asthmatic patients aged 1 to 6 years and receiving
a daily dose.
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Melvyl
Use this configuration file: MELVYL.CFG
Sample Melvyl record from the Computer Articles database:

1.
AN  14625271
DT  ARTICLE - Product Announcement
PA  Lawton, Stephen
AT  Internet access could get cable TV boost. (Zenith
    Electronics Corp. and Spry Inc. demonstrate system
    to connect to Internet over cable TV lines)
    (Product Announcement)
JT  Digital News & Review
VO  10
NR  20
IS  Oct 25
DP  1993
PG  9(1)
ZZ
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OVID Online
Use this configuration file: OVID Online.CFG
Sample OVID Online record from the Biosis database:

    8 of 30
AN 095002594
AU Eichholz M W.  Koenig W D.
IN HASTINGS RESERVATION, UNIV. CALIF., 38601 EAST
   CARMEL VALLEY ROAD, CARMEL VALLEY, CALIF. 93224,
   USA.
TI GOPHER SNAKE ATTRACTION TO BIRDS’ NESTS.
SO Southwestern Naturalist 37 (3). 1992. 293-298.
KW PITUOPHIS-CATENIFER PITUOPHIS-MELANOLEUCUS
   LAMPROPELTIS-GETULUS SIALIA-MEXICANA PREDATION.
CC *Behavioral Biology/Animal Behavior [07003]
   *Ecology; Environmental Biology/Animal [07508]
BC Biosystematic Codes/Super Taxonomic Groups:
   Serpentes [85410]
   Passeriformes [85548]
   Animals.  Chordates.  Vertebrates.  Nonhuman
   Vertebrates. Reptiles. Birds.
AB Snakes, primarily gopher snakes (Pituophis
   catenifer, formerly P. melanleucus) but also common
   kingsnakes (Lampropeltis getulus), commonly
   depradate nests of western bluebirds (Sialia
   mexicana) and other avian species at Hastings
   Reservation in central coastal California.  Snakes
   preferentially climb trees containing active nests
   of western bluebirds situated in artificial
   nestboxes. Snakes rarely attack nests containing
   eggs, and attractiveness appears to increase with
   nestling age.
LG English.
PT Article.
IS 0038-4909
UP 9300
YR 1992
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OVID OVID
Use this configuration file: OVID OVID.CFG
Sample OVID OVID record from the Cinahl database:

<4>
Accession Number
  1993173623   NLM Unique Identifier: 93372535.
Authors
  Davis JE.
Title
  Ethical and legal issues in suicide.
Source
  British Journal of Nursing.  2(15):777-80,
  1993 Aug 12-Sep 8.  (23 ref)
Document Delivery
  NLM Serial Identifier: SR0074170.
Journal Subset
  Nursing Journals.  Peer Reviewed Journals.  UK &
  Ireland Journals.
Cinahl Subject Headings
  Autonomy, *Decision Making, Ethical, *Ethics,
  Nursing, Suicide/lj [Legislation and Jurisprudence],
  *Suicide, *Suicide, Attempted, United Kingdom
Abstract
  Nurse-patient encounters are influenced by the law
  and by morality. These frequently overlap and hold
  certain principles in common, such as justice and
  rights. Despite such close connections, the law and
  morality do not necessarily correspond. The
  difficulty in and complexity of reaching the right
  and just decision in the healthcare setting often
  highlight this.
  (23 ref)
ISSN
  0966-0461
Publication Type
  Journal.  Tables/Charts.
Language
  English.
Entry Month
  9312
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OVID Reprint
Use this configuration file: OVID Reprint.CFG
Sample OVID Reprint record from the Embase 95 database:

10
UI  - 95033424
AU  - Meijer JG
AU  - Van Wieringen N
AU  - Koedooder C
AU  - Nieuwenhuys GJ
AU  - Van Dijk JDP
IN  - Kamerlingh Onnes Laboratory, Leiden State
      University, Leiden; Netherlands.
CP  - United States of America
TI  - The development of PdNi thermoseeds for
      interstitial hyperthermia.
SO  - Medical Physics Vol 22(1) (pp 101-104), 1995.
MH  - Cancer Therapy
MH  - Magnetism
MH  - Priority Journal
MH  - Article
MH  - *Ferromagnetic Material
MH  - *Palladium
MH  - *Nickel
AB  - Magnetic induction heating of thermoseed
      implants can be used to produce highly localized
      hyperthermia in deep-seated tumors. Automatic
      temperature control throughout the tumor can be
      achieved by the self-regulating character of
      ferromagnetic seeds, which corrects for local
      variations in heat loss due to blood perfusion.
      An increased sharpness of the ferromagnetic
      transition at the Curie temperature, T(c),
      improves the performance of self-regulating
      control. This was realized for palladium-nickel
      alloys by a ‘cold working’ procedure preceded
      and followed by annealing. Palladium nickel
      seeds with a predetermined T(c) were produced,
      showing a sharp decrease at T(c) of the magnetic
      susceptibility and the heat production.
RN  - 7440-02-0
IS  - 0094-2405
LG  - English
PT  - Journal
EM  - 9503



144          Appendix C:  Sample  Download Files

ProQuest
Use one of these configuration files: ProQuest.CFG

ProQuest 2.CFG

ProQuest databases vary in how fields are saved to disk.  A single
configuration file cannot accurately transfer text from all databases. See
your ProCite User's Guide, Appendix C: Configuration Files to determine
which configuration file works with each ProQuest database.

Sample ProQuest record from the ABI/Inform Global Edition database
(transfers with ProQuest.CFG):

 Access No:   00861941  ProQuest  ABI/INFORM (R)
              Global Edition
 Title:       New definitions, perceptions needed in
              healthcare debate
 Authors:     Toomey, Robert E
 Journal:     Modern Healthcare (MHC)  ISSN: 0160-7480
              Vol: 24  Iss: 23  Date: Jun 6, 1994
              p: 30
 Subjects:    Health care policy; Reforms; Health care
              networks; Health care delivery;
              Definitions; Perceptions
 Geo Places:  US
 Codes:       1200 (Social policy); 8320 (Health care
              industry); 9190 (United States)

 Abstract:    Everyone seems to believe that
   community-care networks and regional, comprehensive
   systems are needed to make healthcare affordable.
   If that is true, the major stumbling blocks to
   building such systems need to be identified and
   steps taken to make them operationally effective.
   The notion of community and the meaning of
   healthcare must be redefined.  More attention must
   be paid to health status, as well as disease
   status, and social models of care must be built
   that incorporate community-based efforts to improve
   health status as well as to cure diseases.
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SilverPlatter
Use this configuration file: SilverPlatter (SPIRS).CFG
Sample SilverPlatter record from the Medline database:

Record 10 of 26 - MEDLINE (R) 1994
TI:    Protective effect of albuterol delivered via a
spacer device (Babyhaler) against methacholine induced
bronchoconstriction in young wheezy children.
AU:    Avital-A; Godfrey-S; Schachter-J; Springer-C
SO:    Pediatr-Pulmonol. 1994 May; 17(5): 281-4
LA:    ENGLISH
AB:    Nine young asthmatic children aged 2-5 years
underwent methacholine challenge after placebo or
albuterol administered by metered dose inhaler through
a spacer device (Babyhaler) with a face mask in a
double-blind, cross-over, randomized study. The
methacholine challenge was performed using chest
auscultation to define the provocative concentration
of methacholine that causes wheezing (PCW). The PCW
increased from a geometric mean of 0.28 mg/mL after
placebo to 3.59 mg/mL after albuterol (P < 0.0001).
The protective effect of albuterol against
methacholine-induced bronchospasm was 3.7 +/- 1.2
doubling doses. We conclude that administration of
drugs from a metered dose inhaler through the
Babyhaler with a face mask is effective. Albuterol
causes a major reduction in the bronchial
hyperreactivity in young wheezy children shortly after
administration.
MESH:  Asthma-physiopathology; Child,-Preschool;
Double-Blind-Method; Respiratory-Sounds
MESH:  *Albuterol-administration-and-dosage; *Asthma-
drug-therapy; *Bronchial-Provocation-Tests;
*Bronchoconstriction-drug-effects; *Methacholine-
Chloride-diagnostic-use; *Nebulizers-and-Vaporizers
AN:    94336321
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STN
Use one of these configuration files: STN (4 tag area).CFG

STN (5 tag area).CFG
STN (6 tag area).CFG

STN databases vary in how fields are saved to disk. Depending on the
database, the tag area (from the left margin to field text) is either four,
five, or six characters. A single configuration file cannot accurately
transfer text from all three formats. See your ProCite User's Guide,
Appendix C: Configuration Files to determine which configuration file
works with each STN database. Or, examine your download file to
determine the tag area width.

Sample STN record from the Inspec database, which transfers with the
STN (4 tag area).CFG file:

L8   ANSWER 10 OF 10  COPYRIGHT 1993 IEE
AN  71:281893  INSPEC     DN  A71051986
TI  Acetate glasses.
AU  Van Uitert, L.G.; Bonner, W.A.; Grodkiewicz, W.H.
    (Bell Telephone Labs. Inc., Murray Hill, NJ, USA)
SO  Materials Research Bulletin (June 1971) vol.6,
    no.6, p.513-18  CODEN: MRBUAC  ISSN: 0025-5408
DT  Journal
TC  Experimental
CY  United States
LA  English
AB  A number of new glasses have been prepared. These
    include Y and/or rare earth CH3- and   ***CF3***
    -acetates with and without alkali metal acetate
    additions. Like the nitrate glasses these
    materials melt in the 100 to 350 degrees C range
    and tend to be most stable for anion to cation
    ratios of approximately 1.4. The trivalent ions of
    Sm, Eu, Tb and Dy fluoresce under long wave u.v.
    and spark coil excitation in these materials.
CC  A6140D Glasses
CT  GLASS;   ***LUMINESCENCE***   OF ORGANIC SOLIDS;
    ORGANIC COMPOUNDS
ST  acetate glasses; rare earth; Y; alkali metal
    acetate; trivalent ions; spark coil excitation;
    long wave ultraviolet
ET  Y; C*H; CH3; C cp; cp; H cp; C*F; CF3; F cp; C;
    Sm; Eu; Tb; Dy
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Appendix D

Configuration Files

Overview
This appendix lists configuration files supplied in order to import tagged
records from various information services into a ProCite database. The
following is a list of database services that are supported by ProCite, in
alphabetical order by provider.

• CC on CD OVID.cfg  (Current Contents)
• CC on CD Reprint.cfg  (Current Contents)
• Dialog.cfg
• MEDLARS.cfg  (National Library of Medicine)
• Melvyl.cfg
• OVID Online.cfg  (formerly CD-Plus OVID Online)
• OVID OVID.cfg  (formerly CD-Plus OVID)
• OVID Reprint.cfg  (formerly CD-Plus OVID Reprint)
• PROQUEST.cfg
• PROQUEST 2.cfg
• SilverPlatter (SPIRS).cfg
• STN 4 (4 tag area).cfg
• STN 5 (5 tag area).cfg
• STN 6 (6 tag area).cfg

For each configuration file, this appendix lists the databases supported.
Some systems do not offer multiple databases. Proquest and STN require
different configuration files depending upon the database from which the
records were retrieved.

These configuration files were accurate at time of creation. However,
each system periodically updates its offerings, and may alter the layout of
retrieved records. You can modify any of the configuration files, or create
entirely new configuration files, with the Biblio-Link II program found in
your ProCite folder.
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CC on CD OVID (Current Contents)

CC on CD Reprint (Current Contents)

Dialog

Database Description ProCite Workform

1 ...... ERIC ............................................................................ Journal Long Form
2 ...... INSPEC (1969-) ........................................................... Journal Long Form
3 ...... INSPEC (1969-1982) .................................................. Journal Long Form
4 ...... INSPEC (1983-) ........................................................... Journal Long Form
5 ...... BIOSIS PREVIEWS (1969-) ........................................ Journal Long Form
6 ...... NTIS ............................................................................ Report
7 ...... SOCIAL SCISEARCH ................................................. Journal Long Form
8 ...... COMPENDEX PLUS ................................................... Journal Long Form

10 ...... AGRICOLA (1979-) ..................................................... Journal Long Form
11 ...... PSYCINFO .................................................................. Journal Long Form
15 ...... ABI/INFORM................................................................ Journal Long Form
16 ...... PTS PROMT................................................................ Journal Long Form
18 ...... PTS F&S INDEX.......................................................... Journal Long Form
23 ...... CLAIMS/U.S. PatentS (1950-1970) ............................. Patent
24 ...... CLAIMS/U.S. PatentS (1971-1981) ............................. Patent
25 ...... CLAIMS/U.S. PatentS (1982-) ..................................... Patent
32 ...... METADEX ................................................................... Journal Long Form
34 ...... SCISEARCH (1988- ) .................................................. Journal Long Form
35 ...... Dissertation ABSTRACTS ONLINE ............................. Dissertation
36 ...... LINGUISTICS AND LANGUAGE BEHAVIOR A .......... Journal Long Form
37 ...... SOCIOLOGICAL ABSTRACTS ................................... Journal Long Form
38 ...... AMERICA: HISTORY AND LIFE ................................. Journal Long Form
39 ...... HISTORICAL ABSTRACTS ......................................... Journal Long Form
42 ...... PHARMACEUTICAL NEWS INDEX (PNI) .................. Journal Long Form
46 ...... A-V ONLINE ................................................................ Audiovisual Material
47 ...... MAGAZINE INDEX ...................................................... Journal Long Form
50 ...... CAB ABSTRACTS (1984-) .......................................... Journal Long Form
51 ...... FOOD SCIENCE AND TECHNOLOGY ABSTRAC ..... Journal Long Form
53 ...... CAB ABSTRACTS (1972-1983) .................................. Journal Long Form
55 ...... BIOSIS PREVIEWS (1985-) ........................................ Journal Long Form
56 ...... ARTBIBLIOGRAPHIES MODERN .............................. Journal Long Form
58 ...... GEOARCHIVE............................................................. Journal Long Form
61 ...... LISA ............................................................................. Journal Long Form
62 ...... SPIN ............................................................................ Journal Long Form
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Database ..... Description................................................................... ProCite Workform

64 ...... CHILD ABUSE AND NEGLECT AND FAMILY ............ Journal Long Form
68 ...... ENVIRONMENTAL BIBLIOGRAPHY .......................... Journal Long Form
69 ...... ENERGYLINE ............................................................. Journal Long Form
72 ...... EMBASE (1985-) ......................................................... Journal Long Form
73 ...... EMBASE (1974-) ......................................................... Journal Long Form
74 ...... INTERNATIONAL PHARMACEUTICAL ABSTRA ....... Journal Long Form
75 ...... MANAGEMENT CONTENTS ...................................... Journal Long Form
76 ...... LIFE SCIENCES COLLECTION ................................. Journal Long Form
77 ...... CONFERENCE PAPERS INDEX ................................ Conference Proceedings
86 ...... MENTAL HEALTH ABSTRACTS ................................. Journal Long Form
88 ...... ACADEMIC INDEX...................................................... Journal Long Form
89 ...... GEOREF ..................................................................... Journal Long Form
97 ...... MUSIC LITERATURE INTERNATIONAL (RIL ............. Journal Long Form

103 ...... ENERGY SCIENCE & TECHNOLOGY ....................... Journal Long Form
108 ...... AEROSPACE DATABASE ........................................... Journal Long Form
109 ...... NUCLEAR SCIENCE ABSTRACTS ............................ Journal Long Form
110 ...... AGRICOLA (1970-1978) ............................................. Journal Long Form
111 ...... NATIONAL Newspaper INDEX .................................... Newspaper
125 ...... CLAIMS/U.S. PATENTS(Current) ................................ Patent
136 ...... FEDERAL REGISTER ABSTRACTS .......................... Journal Long Form
144 ...... PASCAL....................................................................... Journal Long Form
146 ...... WASHINGTON POST ................................................. Newspaper
148 ...... TRADE AND INDUSTRY INDEX ................................. Journal Long Form
149 ...... HEALTH PERIODICALS DATABASE .......................... Journal Long Form
150 ...... LEGAL RESOURCE INDEX ........................................ Journal Long Form
151 ...... HEALTH PLANNING AND ADMINISTRATION ........... Journal Long Form
152 ...... MEDLINE (1966-1974) ................................................ Journal Long Form
153 ...... MEDLINE (1975-1984) ................................................ Journal Long Form
154 ...... MEDLINE (1985-) ........................................................ Journal Long Form
155 ...... MEDLINE (1966-) ........................................................ Journal Long Form
156 ...... TOXLINE ..................................................................... Journal Long Form
157 ...... AIDSLINE .................................................................... Journal Long Form
158 ...... DIOGENES.................................................................. Journal Long Form
159 ...... CANCERLIT ................................................................ Journal Long Form
185 ...... ZOOLOGICAL RECORD ONLINE .............................. Journal Long Form
192 ...... INDUSTRY TRENDS AND ANALYSIS ........................ Report
202 ...... INFORMATION SCIENCE ABSTRACTS .................... Journal Long Form
203 ...... AGRIS INTERNATIONAL ............................................ Journal Long Form
211 ...... NEWSEARCH (Daily updates for Files ....................... Journal Long Form
218 ...... NURSING AND ALLIED HEALTH (CINAHL) ............... Journal Long Form
223 ...... CLAIMS/U.S. PATENTS (UNITERM, 1950- ................ Patent
224 ...... CLAIMS/U.S. PATENTS (UNITERM, 1971- ................ Patent
225 ...... CLAIMS/U.S. PATENTS (UNITERM, 1982- ................ Patent
233 ...... MICROCOMPUTER INDEX ........................................ Journal Long Form
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Database Description ProCite Workform

239 ...... MATHSCI ..................................................................... Journal Long Form
257 ...... API ENERGY BUSINESS NEWS INDEX (API ............ Journal Long Form
258 ...... AP NEWS .................................................................... Newspaper
260 ...... UPI NEWS (1983-, except last 3 mont ........................ Newspaper
261 ...... UPI NEWS (Current 3 months) ................................... Newspaper
262 ...... CANADIAN BUSINESS AND CURRENT AFFAI ......... Journal Long Form
275 ...... COMPUTER DATABASE ............................................ Journal Long Form
293 ...... ENGINEERED MATERIALS ABSTRACTS ................. Journal Long Form
299 ...... MAGILL’S SURVEY OF CINEMA ................................ Motion Picture
308 ...... CA SEARCH (1967-1971) ........................................... Journal Long Form
309 ...... CA SEARCH (1972-1976) ........................................... Journal Long Form
310 ...... CA SEARCH (1977-1981) ........................................... Journal Long Form
311 ...... CA SEARCH (1982-1986) ........................................... Journal Long Form
312 ...... CA SEARCH (1987-1991) ........................................... Journal Long Form
313 ...... CA SEARCH (1992- ) .................................................. Journal Long Form
323 ...... RAPRA ABSTRACTS .................................................. Journal Long Form
340 ...... CLAIMS/U.S. PATENTS (1950-) ................................. Patent
341 ...... CLAIMS/U.S. PATENTS (UNITERM, 1950- ................ Patent
345 ...... INPADOC/FAMILY AND LEGAL STATUS ................... Patent
350 ...... WORLD PATENTS INDEX (1963-1980) ..................... Patent
351 ...... WORLD PATENTS INDEX (1981-) ............................. Patent
399 ...... CA SEARCH (1967-) ................................................... Journal Long Form
421 ...... REMARC (-1900) ........................................................ Book Long Form
422 ...... REMARC (1900-1939) ................................................ Book Long Form
423 ...... REMARC (1940-1959) ................................................ Book Long Form
424 ...... REMARC (1960-1969) ................................................ Book Long Form
425 ...... REMARC (1970-1980) ................................................ Book Long Form
426 ...... LC MARC - BOOKS .................................................... Book Long Form
430 ...... BRITISH BOOKS IN PRINT ........................................ Book Long Form
434 ...... SCISEARCH (1974- ) .................................................. Journal Long Form
439 ...... ARTS AND HUMANITIES SEARCH ........................... Journal Long Form
440 ...... CURRENT CONTENTS SEARCH .............................. Journal Long Form
442 ...... AMERICAN MEDICAL ASSOCIATION JOURNAL ...... Journal Long Form
444 ...... NEW ENGLAND JOURNAL OF MEDICINE ONL ....... Journal Long Form
470 ...... BOOKS IN PRINT ....................................................... Book Long Form
484 ...... NEWSPAPER AND PERIODICAL ABSTRACTS ........ Journal Long Form
498 ...... DETROIT FREE PRESS ............................................. Newspaper
581 ...... AGRIBUSINESS U.S.A. .............................................. Journal Long Form
583 ...... INFOMAT INTERNATIONAL BUSINESS .................... Journal Long Form
603 ...... NEWSPAPER ABSTRACTS ....................................... Newspaper
609 ...... KNIGHT-RIDDER/TRIBUNE BUSINESS NEWS ........ Newspaper
610 ...... BUSINESSWIRE ......................................................... Newspaper
615 ...... AGENCE FRANCE PRESSE INTERNATIONAL ........ Newspaper
630 ...... LOS ANGELES TIMES ................................................ Newspaper
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Database Description ProCite Workform

631 ...... BOSTON GLOBE ........................................................ Newspaper
632 ...... CHICAGO TRIBUNE ................................................... Newspaper
633 ...... PHILADELPHIA INQUIRER ........................................ Newspaper
636 ...... PTS NEWSLETTER DATABASE ................................ Journal Long Form
638 ...... NEWSDAY and NEW YORK NEWSDAY .................... Newspaper
640 ...... SAN FRANCISCO CHRONICLE ................................. Newspaper
647 ...... MAGAZINE ASAP ....................................................... Journal Long Form
648 ...... TRADE AND INDUSTRY ASAP .................................. Journal Long Form
649 ...... NEWSWIRE ASAP ...................................................... Newspaper
669 ...... FEDERAL REGISTER ................................................. Journal Long Form
675 ...... COMPUTER ASAP...................................................... Journal Long Form
703 ...... USA TODAY ................................................................ Newspaper
710 ...... TIMES/SUNDAY TIMES (LONDON) ........................... Newspaper
711 ...... INDEPENDENT (LONDON) ........................................ Newspaper
715 ...... CHRISTIAN SCIENCE MONITOR .............................. Newspaper
716 ...... DAILY NEWS OF LOS ANGELES ............................... Newspaper
717 ...... WASHINGTON TIMES ................................................ Newspaper
731 ...... PHILADELPHIA DAILY NEWS .................................... Newspaper
772 ...... TEXTLINE: UNITED KINGDOM NEWS ...................... Newspaper
773 ...... TEXTLINE: EUROPEAN NEWS ................................. Newspaper
774 ...... TEXTLINE: NORTH/CENTRAL/SOUTH AMERI ......... Newspaper
775 ...... TEXTLINE: MIDEAST/AFRICAN NEWS ..................... Newspaper
776 ...... TEXTLINE: ASIAN/AUSTRALIAN NEWS ................... Newspaper
777 ...... TEXTLINE: WORLDWIDE JOURNALS ...................... Newspaper
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MEDLARS (National Library of Medicine)

Database Description ProCite Workform

AIDSLINE .............. AIDSLINE ............................................................... Conference Proceedings
AVLINE.................. AVLINE: Audiovisual Online .................................... Audiovisual Material
BACK66 ................ BACK66: MEDLINE (1966-1974) ........................... Journal Long Form
BACK75 ................ BACK75: MEDLINE (1975-1979) ........................... Journal Long Form
BACK77 ................ BACK77: MEDLINE (1975-1979) ........................... Journal Long Form
BACK80 ................ BACK80: MEDLINE (1980-1985) ........................... Journal Long Form
BACK83 ................ BACK83: MEDLINE (1980-1985) ........................... Journal Long Form
BACK85 ................ BACK85: MEDLINE (1985-1989) ........................... Journal Long Form
BACK90 ................ BACK90: MEDLINE (1990-1993) ........................... Journal Long Form
BIOETHICS ........... BIOETHICSLINE .................................................... Journal Long Form
BIOTECHSEEK..... Biotechseek ............................................................ Journal Long Form
CANCERLINE ....... CANCERLINE (CANCERLIT) ................................. Journal Long Form
CANCERLIT .......... CANCERLIT ........................................................... Journal Long Form
CATLINE ............... NLM CATALOG ONLINE ........................................ Book Long Form
HEALTH ................ HEALTH PLANNING AND ADMINISTRATION ....... Journal Long Form
HISTORY
OF MEDICINE....... HISTORY OF MEDICINE ONLINE ......................... Journal Long Form
MED66 .................. MED66: MEDLINE (1966-1974) ............................. Journal Long Form
MED75 .................. MED75: MEDLINE (1975-1979) ............................. Journal Long Form
MED80 .................. MED80: MEDLINE (1980-1984) ............................. Journal Long Form
MED85 .................. MED85: MEDLINE (1985-1989) ............................. Journal Long Form
MEDLINE .............. MEDLINE: MEDLINE (1990-1993) ......................... Journal Long Form
POPLINE............... POPULATION INFORMATION ONLINE ................ Journal Long Form
SDILINE ................ MEDLINE: CURRENT FULL MONTH .................... Journal Long Form
TOXLINE ............... TOXICOLOGY LITERATURE ONLINE (1981- ) ..... Journal Long Form
TOXLINE65 ........... TOXICOLOGY LITERATURE ONLINE ( -1980) ..... Journal Long Form
TOXLIT .................. TOXICOLOGY LITERATURE

FROM SPECIAL SOURCES (1981-) ...................... Journal Long Form
TOXLIT65.............. TOXICOLOGY LITERATURE

FROM SPECIAL SOURCES (-1980) ...................... Journal Long Form
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Melvyl

Database Description ProCite Workform

ABI/INFORM .................... ABI/Inform Database ...................... Journal Long Form
COMP .............................. IAC's Computer Database .............. Journal Long Form
CURRENT CONTENT ..... Current Contents Database ............ Journal Long Form
INSPEC ............................ INSPEC Database .......................... Journal Long Form
MAGS............................... IAC's Expanded Academic Index .... Journal Long Form
MEDLINE ......................... MEDLINE Database ....................... Journal Long Form
MONOGRAPHS ............... UC Monographs Database ............. Book Long Form
NEWS .............................. IAC's National Newspaper Index .... Newspaper
PERIODICALS ................. UC Periodicals Database ................ Journal Whole
PSYCHINFO .................... PsycInfo Database .......................... Journal Long Form

OVID Online

Database Description ProCite Workform

AARP .......... AgeLine ....................................................................... Journal Long Form
AGRI ........... Current Contents: Agriculture, Biology & Envir ............ Journal Long Form
AIDS ............ AidsLine ....................................................................... Journal Long Form
ARTS........... Current Contents: Arts & Humanities .......................... Journal Long Form
BBIP ............ Books in Print .............................................................. Book Long Form
BEHA .......... Current Contents: Social & Behavioral Science .......... Journal Long Form
BIOB............ BIOSIS (1970 to 1977) ................................................ Journal Long Form
BIOE............ Bioethicsline ................................................................ Journal Long Form
BIOL ............ BIOSIS (1978 to Date) ................................................ Journal Long Form
BIOZ ............ BIOSIS (1970 to Date) ................................................ Journal Long Form
CANR .......... CancerLit ..................................................................... Journal Long Form
CCML .......... Comprehensive Core Medical Library ......................... Journal Long Form
CCON.......... Current Contents Online .............................................. Journal Long Form
CDEX .......... Compendex Plus ......................................................... Journal Long Form
CHID ........... Combined Health Information Database ..................... Journal Long Form
CHIR ........... Chirolars ...................................................................... Journal Short Form
CLIN ............ Current Contents: Clinical Medicine ............................ Journal Long Form
CTOC .......... Current Contents Search ............................................. Journal Long Form
DISS ............ Dissertation Abstracts Online ...................................... Dissertation
EMED .......... Excerpta Medica (1988 to Present) ............................. Journal Long Form
EPIL ............ National Epilepsy Library Database ............................ Journal Long Form
ERIC............ ERIC ............................................................................ Journal Long Form
ETOH .......... Alcohol & Alcohol Problems Science Databas ............ Journal Long Form
HLTH ........... Health Planning and Administration ............................ Journal Long Form
INFO............ ABI/INFORM................................................................ Journal Long Form
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Database Description ProCite Workform

IPAB ............ International Pharmaceutical Abstracts ....................... Journal Long Form
LIFE............. Current Contents: Life Sciences .................................. Journal Long Form
MESH .......... Medline (1986-present) ............................................... Journal Long Form
NAHL........... Nursing & Allied Health ................................................ Journal Long Form
NTIS ............ National Technical Information Service ....................... Report
PHAR .......... Pharmaprojects Current .............................................. Data File
PHYS .......... Current Contents: Physical, Chemical & Earth ............ Journal Long Form
PSYC .......... PsycINFO .................................................................... Journal Long Form
REFU .......... Reference Update ....................................................... Journal Short Form
SOCA .......... Sociological Abstracts ................................................. Journal Long Form
TECH .......... Current Contents: Engineering, Tech & Applie ............ Journal Long Form
WAST .......... Wilson Applied Science & Technology Index ............... Journal Long Form
WBAI ........... Wilson Biological & Agricultural Index ......................... Journal Long Form
WGSI........... Wilson General Science Index .................................... Journal Long Form
WHUM......... Wilson Humanities Index ............................................. Journal Long Form
WRGA ......... Wilson Readers Guide Abstracts ................................. Journal Long Form
WSSI ........... Wilson Social Sciences Index ..................................... Journal Long Form

OVID OVID

Database Description ProCite Workform

AIDSLINE ............................. AIDSLine .......................................................... Journal Long Form
BIOETHICSLINE .................. BioethicsLine .................................................... Journal Long Form
BIOLOGICAL ABSTRACTS . Biological Abstracts .......................................... Journal Long Form
BIOSIS PREVIEWS ............. BIOSIS Previews .............................................. Journal Long Form
CANCERLIT ......................... CancerLit .......................................................... Journal Long Form
CINAHL ................................ Nursing and Allied Health ................................. Journal Long Form
CLINPSYC ........................... ClinPSYC ......................................................... Journal Long Form
EMBASE80 .......................... Embase: Drugs & Pharmacology (1980-1986) Journal Long Form
EMBASE87 .......................... Embase: Drugs & Pharmacology (1987-1990) Journal Long Form
EMBASE91 .......................... Embase: Drugs & Pharmacology (1991-1992) Journal Long Form
EMBASE93 .......................... Embase: Drugs & Pharmacology (1993-1994) Journal Long Form
EMBASE95 .......................... Embase: Drugs & Pharmacology (1995-) ......... Journal Long Form
EMED88 ............................... Embase (1988-1990) ....................................... Journal Long Form
EMED91 ............................... Embase (1991-1993) ....................................... Journal Long Form
EMED94 ............................... Embase (1994-) ............................................... Journal Long Form
ERIC..................................... Eric ................................................................... Journal Long Form
HEALTH ............................... Health Planning and Administration ................. Journal Long Form
IPA........................................ International Pharmaceutical Abstracts ............ Journal Long Form
MDX ..................................... MDX Health Digest ........................................... Journal Long Form
MEDLINE ............................. Medline ............................................................. Journal Long Form
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Database Description ProCite Workform

NEJM ................................... New England Journal of Medicine .................... Journal Long Form
PHENYTOIN ........................ Phenytoin Database ......................................... Journal Long Form
PSYCINFO ........................... PsycINFO ......................................................... Journal Long Form
PSYCLIT .............................. PsycLit .............................................................. Journal Long Form
WILSON
BUSINESS ABSTRACTS .... Wilson Business Abstracts ............................... Journal Long Form

OVID Reprint

Database .................................... Description .............................................. ProCite Workform

AIDSLINE .................................... AIDSLine ................................................... Journal Long Form
BIOETHICSLINE ......................... BioethicsLine ............................................. Journal Long Form
BIOLOGICAL ABSTRACTS ........ Biological Abstracts (BIOSIS) ................... Journal Long Form
BIOSIS PREVIEWS .................... BIOSIS Previews....................................... Journal Long Form
CANCERLIT ................................ CancerLit ................................................... Journal Long Form
CINAHL ....................................... Nursing and Allied Health .......................... Journal Long Form
CLINPSYC .................................. ClinPSYC .................................................. Journal Long Form
EMBASE: DRUGS & PHARM ..... Embase: Drugs and Pharmacology .......... Journal Long Form
ERIC............................................ ERIC.......................................................... Journal Long Form
HEALTH ...................................... Health Planning and Administration .......... Journal Long Form
IPA............................................... International Pharmaceutical Abstracts ..... Journal Long Form
MDX ............................................ MDX Health Digest ................................... Journal Long Form
MEDLINE .................................... Medline...................................................... Journal Long Form
PHENYTOIN ............................... Phenytoin Database .................................. Journal Long Form
PSYCHINFO ............................... PsychINFO ................................................ Journal Long Form
PSYCLIT ..................................... PsycLit ....................................................... Journal Long Form
WILSON ...................................... Wilson Business Abstracts ........................ Journal Long Form
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PROQUEST

Database Description ProCite Workform

ABI/INFORM GLOBAL ................ ABI/Inform Global Edition .......................... Journal Long Form
ABI/INFORM RESEARCH .......... ABI/Inform Research Edition ..................... Journal Long Form
ABI/INFORM SELECT ................ ABI/Inform Select Edition .......................... Journal Long Form
ACCOUNTING & TAX ................. Accounting & Tax Database ...................... Journal Long Form
DISSERTATION - HUMANITIES . Dissertation Abstracts - Hum. & Soc. Sci. . Dissertation
DISSERTATION - SCIENCES..... Dissertation Abstracts - Sciences & Engin. Dissertation
DISSERTATION ABSTRACTS .... Dissertation Abstracts ............................... Dissertation
PERIODICAL ABSTRACTS -
LIBRARY ..................................... Periodical Abstracts Library Edition........... Journal Long Form
PERIODICAL ABSTRACTS -
SELECT ...................................... Periodical Abstracts Select Edition............ Journal Long Form
PERIODICAL ABSTRACTS I ...... Periodical Abstracts Research I Edition .... Journal Long Form
PERIODICAL ABSTRACTS II ..... Periodical Abstracts Research II Edition ... Journal Long Form

PROQUEST 2

Database Description ProCite Workform

NEWSPAPER ABSTRACTS ....... Newspaper Abstracts ................................ Newspaper
NEWSPAPER ABSTRACTS -
NATIONAL .................................. Newspaper Abstracts - National ................ Newspaper
RESOURCE/ONE ....................... Resource/One ........................................... Journal Long Form
RESOURCE/ONE SELECT ........ Resource/One Select ................................ Journal Long Form
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SilverPlatter (SPIRS)

Database Description ProCite Workform

A-V ONLINE .................................... A-V ONLINE .......................................... Audiovisual Material
AGRICOLA...................................... AGRICOLA ............................................ Journal Long Form
AGRIS ............................................. AGRIS ................................................... Journal Long Form
AIDSLINE ........................................ AIDSLINE .............................................. Journal Long Form
ANALYTICAL .................................. Analytical Abstracts ............................... Journal Long Form
ANESTHESIOLOGY ....................... Excerpta Medica - Anesthesiology ........ Journal Long Form
BA ON CD ....................................... Biological Abstracts on CD .................... Journal Long Form
BA/RRM ON CD.............................. Biological Abstracts/RRM on CD ........... Journal Long Form
BEASTCD ....................................... BEASTCD.............................................. Journal Long Form
BIOTECH ........................................ Biotechnology Abstracts ........................ Journal Long Form
CAB ABSTRACTS .......................... CAB ABSTRACTS Database on CD ..... Journal Long Form
CABPESTCD .................................. CABPESTCD......................................... Journal Long Form
CANCER-CD................................... CANCER-CD ......................................... Journal Long Form
CARDIOLOGY ................................ Excerpta Medica - Cardiology ............... Journal Long Form
CINAHL ........................................... Nursing & Allied Health (CINAHL)-CD ... Journal Long Form
CLINPSYC ...................................... ClinPSYC............................................... Journal Long Form
COMPUTER LIBRARY ................... OCLC Computer Library ........................ Book Long Form
Cross Cultural ................................. Cross-Cultural CD ................................. Book Long Form
Death and Dying ............................. Cross-Cultural CD - Death and Dying ... Book Long Form
DRUGS & PHARMACOLOGY ........ 1/95-7/95 Excerpta Medica -

Drugs and Pharmacology ...................... Journal Long Form
ECONLIT......................................... EconLit ................................................... Journal Long Form
EDUCATION LIBRARY ................... OCLC Education Library ....................... Book Long Form
EMBASE ALERT CD ....................... EMBASE Alert CD ................................. Journal Long Form
EMBASE CD ................................... EMBASE CD ......................................... Journal Long Form
ENVIRONMENTAL LIBRARY ......... OCLC Environmental Library ................. Book Long Form
ERIC................................................ ERIC ...................................................... Journal Long Form
ETDE............................................... ETDE Energy Database ........................ Journal Long Form
EXCERPTA MEDICA ...................... Excerpta Medica Library Service ........... Journal Long Form
F&S INDEX ..................................... F&S INDEX plus TEXT .......................... Journal Long Form
FOOD & HUMAN NUTRITION........ Food and Human Nutrition in AGRIS..... Journal Long Form
FOODS INTELLIGENCE ................ Foods Intelligence on Compact Disc ..... Journal Long Form
FSTA ............................................... FSTA on CD-ROM ................................. Journal Long Form
GASTROENTEROLOGY ................ Excerpta Medica - Gastroenterology ..... Journal Long Form
GEOREF ......................................... GeoRef .................................................. Journal Long Form
GPO ................................................ GPO on SilverPlatter ............................. Journal Long Form
HEALTHPLAN ................................. HealthPLAN-CD .................................... Journal Long Form
HORTCD ......................................... HORTCD ............................................... Journal Long Form
ICONDA .......................................... ICONDA................................................. Journal Long Form
IMMUNOLOGY & AIDS................... Excerpta Medica -

Immunology and AIDS ........................... Journal Long Form
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Database Description ProCite Workform

INIS ................................................. INIS on SilverPlatter .............................. Journal Long Form
IPA................................................... International Pharmaceutical Abstracts . Journal Long Form
ISA .................................................. Information Science Abstracts Plus ....... Journal Long Form
ISA ERIC Information Science Abstracts

Plus: ERIC Subset ................................. Journal Long Form
LIFE SCIENCES COLLECTION ..... Life Sciences Collection ........................ Journal Long Form
MDX ................................................ MDX Health Digest ................................ Journal Long Form
MEDLINE ........................................ MEDLINE............................................... Journal Long Form
MLA ................................................. MLA International Bibliography .............. Journal Long Form
MUSIC............................................. OCLC Music Library .............................. Sound Recording
NEPHROLOGY ............................... Excerpta Medica - Nephrology .............. Journal Long Form
NEUROSCIENCES ......................... Excerpta Medica - Neurosciences ......... Journal Long Form
NTIS ................................................ NTIS ...................................................... Report
OBSTETRICS & GYNECOLOGY Excerpta Medica -

Obstetrics and Gynecology ................... Journal Long Form
Old Age ........................................... Cross-Cultural CD - Old Age ................. Book Long Form
PAIS ................................................ PAIS International .................................. Journal Long Form
PATHOLOGY .................................. Excerpta Medica - Pathology................. Journal Long Form
POPLINE......................................... POPLINE ............................................... Journal Long Form
PSYCHIATRY.................................. Excerpta Medica - Psychiatry ................ Journal Long Form
PSYCLIT ......................................... PsycLIT .................................................. Journal Long Form
PSYNDEX ....................................... PSYNDEX ............................................. Journal Long Form
RADIOLOGY Excerpta Medica -

Radiology and Nuclear Medicine ........... Journal Long Form
REFERENCE UPDATE................... Reference Update on SilverPlatter ........ Journal Long Form
RINGDOC ....................................... RINGDOC.............................................. Journal Long Form
SIGLE.............................................. SIGLE .................................................... Book Long Form
SOCIAL WORK ............................... Social Work Abstracts Plus .................... Journal Long Form
SOCIOFILE ..................................... Sociofile ................................................. Journal Long Form
SPORT DISCUS ............................. SPORT Discus ...................................... Journal Long Form
TOXLINE ......................................... TOXLINE on SilverPlatter ...................... Journal Long Form
TOXLINE PLUS .............................. TOXLINE PLUS on SilverPlatter ........... Journal Long Form
TREECD ......................................... TREECD ................................................ Journal Long Form
TROPAG ......................................... TROPAG & RURAL ............................... Journal Long Form
VETCD ............................................ VETCD .................................................. Journal Long Form
WASTEINFO ................................... WasteInfo .............................................. Journal Long Form
WATER............................................ Water Resources Abstracts

on SilverPlatter ...................................... Journal Long Form
WATERLIT ...................................... WATERLIT ............................................. Journal Long Form
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STN (4 tag area)

Database Description ProCite Workform

ANABSTR ............. Analytical Abstracts ................................................. Journal Long Form
BIOSIS .................. BIOSIS ..................................................................... Journal Long Form
CEABA .................. Chemical Engineering and Biotechnical Abs ........... Journal Long Form
COMPENDEX ....... COMPENDEX.......................................................... Journal Long Form
CSNB .................... Chemical Safety News Base ................................... Journal Long Form
ICONDA ................ International Construction Database ....................... Journal Long Form
INSPEC ................. INSPEC ................................................................... Journal Long Form
MEDLINE .............. Medline .................................................................... Journal Long Form
NTIS ...................... National Technical Information Service .................... Report

STN (5 tag area)

Database .............. Description ........................................................... ProCite Workform

ABI-INFORM ......... ABI-Inform.............................................................. Journal Long Form
APILIT2 ................. American Petroleum Institute’s Literature db ......... Journal Long Form
APIPAT2 ................ American Petroleum Institute’s Patent db .............. Patent
AQUASCI .............. Aquatic Sciences & Fisheries Abstracts ................ Journal Long Form
BIOBUSINESS ...... Biobusiness ........................................................... Journal Long Form
BLLDB ................... Bibliography of Linguistic Literature dB ................. Journal Long Form
CA ......................... Chemical Abstracts ................................................ Journal Long Form
CABA .................... CAB Abstracts ........................................................ Journal Long Form
CEDB .................... Civil Engineering Database ................................... Journal Long Form
CERAB .................. Ceramic Abstracts .................................................. Journal Long Form
CIN ........................ Chemical Industry Notes ....................................... Journal Long Form
COMPUAB ............ Computer and Information Science Abstracts ....... Journal Long Form
CONF .................... Conferences in Energy, Physics, Math & Chem .... Conference Proceedings
CONFSCI .............. Conference Papers Index ...................................... Conference Proceedings
DISSABS............... Dissertation Abstracts ............................................ Journal Long Form
ELCOM ................. Electronics & Communications Abstracts .............. Journal Long Form
EMBASE ............... EMBASE ................................................................ Journal Long Form
FSTA ..................... Food Science and Technology Abstracts ............... Journal Long Form
GEOREF ............... GeoRef .................................................................. Journal Long Form
ISMEC ................... Mechanical Engineering Abstracts ........................ Journal Long Form
LIFESCI ................. Life Science Collection .......................................... Journal Long Form
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STN (6 tag area)

Database Description ProCite Workform

CBNB ........................ Chemical Business Newsbank ............................. Journal Long Form
COMPUSCIENCE ..... Compuscience ..................................................... Journal Long Form
DDFU ........................ Derwent Drug File (RINGDOC) ............................ Journal Long Form
EMA .......................... Engineered Materials Abstracts ........................... Journal Long Form
ENERGIE .................. Energie ................................................................. Journal Long Form
ENERGY ................... Energy .................................................................. Journal Long Form
INPADOC .................. International Patent Documentation Center ......... Patent
SIGLE........................ System for Info on Grey Literature in Europe ...... Dissertation
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O
Online Help  8
Open Configuration Files  45
Optional Parsing Components  102



Index          163

Options for Field Types  84–89
OVID

online records  141
OVID records  142
reprint records  143

OVID Online, configuration file
153–160

OVID OVID, configuration file
154–160

P
Parse Tagged Subfields  107
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target ProCite fields  86–90
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T
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adding and mapping  77–89
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Tutorial  1 1

U
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by system  60

V
View Download Files  49

W
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selecting by database  71–72
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